
Sun Microsystems, Inc.
4150 Network Circle
Santa Clara, CA 95054 U.S.A.
650-960-1300

Send comments about this document to: docfeedback@sun.com

Forte™ for Java™ 4, Enterprise Edition
Getting Started Guide

Forte for Java 4

Part No. 816-4063-10
June 2002, Revision A



Please
Recycle

Copyright © 2002 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All rights reserved.

Sun Microsystems, Inc. has intellectual property rights relating to technology embodied in the product that is described in this document.

In particular, and without limitation, these intellectual property rights may include one or more of the U.S. patents listed at

http://www.sun.com/patents and one or more additional patents or pending patent applications in the U.S. and in other countries.

This document and the product to which it pertains are distributed under licenses restricting their use, copying, distribution, and

decompilation. No part of the product or of this document may be reproduced in any form by any means without prior written authorization of

Sun and its licensors, if any.

Third-party software, including font technology, is copyrighted and licensed from Sun suppliers.

This product includes code licensed from RSA Data Security.

Sun, Sun Microsystems, the Sun logo, Forte, Java, NetBeans, iPlanet, docs.sun.com, and Solaris are trademarks or registered trademarks of Sun

Microsystems, Inc. in the U.S. and other countries.

All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. in the U.S. and other

countries. Products bearing SPARC trademarks are based upon architecture developed by Sun Microsystems, Inc.

UNIX is a registered trademark in the United States and other countries, exclusively licensed through X/Open Company, Ltd.

Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape Communications Corporation in the United States and

other countries.

Federal Acquisitions: Commercial Software—Government Users Subject to Standard License Terms and Conditions.

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,

INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT,

ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Copyright © 2002 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, Etats-Unis. Tous droits réservés.

Sun Microsystems, Inc. a les droits de propriété intellectuels relatants à la technologie incorporée dans le produit qui est décrit dans ce

document. En particulier, et sans la limitation, ces droits de propriété intellectuels peuvent inclure un ou plus des brevets américains énumérés

à http://www.sun.com/patents et un ou les brevets plus supplémentaires ou les applications de brevet en attente dans les Etats-Unis et

dans les autres pays.

Ce produit ou document est protégé par un copyright et distribué avec des licences qui en restreignent l’utilisation, la copie, la distribution, et la

décompilation. Aucune partie de ce produit ou document ne peut être reproduite sous aucune forme, parquelque moyen que ce soit, sans

l’autorisation préalable et écrite de Sun et de ses bailleurs de licence, s’il y en a.

Le logiciel détenu par des tiers, et qui comprend la technologie relative aux polices de caractères, est protégé par un copyright et licencié par des

fournisseurs de Sun.

Ce produit comprend le logiciel licencié par RSA Data Security.

Sun, Sun Microsystems, le logo Sun, Forte, Java, NetBeans, iPlanet, docs.sun.com, et Solaris sont des marques de fabrique ou des marques

déposées de Sun Microsystems, Inc. aux Etats-Unis et dans d’autres pays.

Toutes les marques SPARC sont utilisées sous licence et sont des marques de fabrique ou des marques déposées de SPARC International, Inc.

aux Etats-Unis et dans d’autres pays. Les produits protant les marques SPARC sont basés sur une architecture développée par Sun

Microsystems, Inc.

UNIX est une marque enregistree aux Etats-Unis et dans d’autres pays et licenciée exclusivement par X/Open Company Ltd.

Netscape et Netscape Navigator sont des marques de Netscape Communications Corporation aux Etats-Unis et dans d’autres pays.

LA DOCUMENTATION EST FOURNIE “EN L’ÉTAT” ET TOUTES AUTRES CONDITIONS, DECLARATIONS ET GARANTIES EXPRESSES

OU TACITES SONT FORMELLEMENT EXCLUES, DANS LA MESURE AUTORISEE PAR LA LOI APPLICABLE, Y COMPRIS NOTAMMENT

TOUTE GARANTIE IMPLICITE RELATIVE A LA QUALITE MARCHANDE, A L’APTITUDE A UNE UTILISATION PARTICULIERE OU A

L’ABSENCE DE CONTREFAÇON.



Contents

Before You Begin vii

1. Preparing for Installation 1

Overview of the Installation 1

Supported Platforms 3

System Requirements 3

2. Installing the J2SE, v. 1.4.0 Platform 5

Verifying Your J2SE Platform Version 5

Installing the J2SE Platform on Microsoft Windows Systems 7

Installing the J2SE Platform in the Red Hat Linux Environment 9

Installing the J2SE Platform in the Solaris Operating Environment 11

Installing Patches in a Solaris 8 Operating Environment 12

Installing the J2SE, v. 1.4.0 Platform in a Solaris 8 Environment 14

Installing the J2SE, v. 1.4.0 Platform in a 32-bit Solaris 8

Environment 15

Installing the J2SE, v. 1.4.0 Supplemental Release for 64-bit Operation in

a Solaris 8 Environment 18

Uninstalling the J2SE, v. 1.4.0 Platform 20
iii



3. Installing the Forte for Java 4 IDE 21

Supporting Previous Forte for Java Software Releases 21

Creating a Shared Installation 22

Installing the Forte for Java 4 IDE on the Supported Platforms 22

Installation on Microsoft Windows Systems 22

Installation in the Red Hat Linux Environment 25

Installation in the Solaris Operating Environments 27

Installing the IDE Using the Command-line Options 31

Finding Installation Subdirectories 34

Uninstalling the Forte for Java 4 IDE 36

4. Using Your Newly Installed Forte for Java 4 IDE 37

Setting Up Your Forte for Java 4 IDE 37

Using the Startup Command-Line Options 41

5. Validating Your Forte for Java 4 Installation 45

Starting the Default J2EE Reference Implementation Instance 45

Creating a HelloWorld J2EE Application 47

6. Customizing Your Installation 51

Using Databases With the Forte for Java IDE 51

Using a PointBase Database 51

Starting the PointBase Database Server 52

Stopping the PointBase Database Server 52

Starting the PointBase Client Console 52

Stopping the PointBase Client Console 53

Customizing Your PointBase Database 53

Using Other JDBC Enabled Databases 54

Using the IDE’s Internal UDDI Registry Server 54
iv Forte for Java 4, Enterprise Edition Getting Started Guide • June 2002



7. Using Other Application Servers With the Forte for Java 4 IDE 57

Setting Up the WebLogic Environment 57

Setting Up the WebLogic Environment in a Solaris Operating

Environment 58

Setting Up the WebLogic Environment on a Microsoft Windows System 59

Configuring the BEA WebLogic Server 6.1 as the Default Application Server 59

8. Where to Go From Here 61

Updating Modules With the Update Center 61

Other Documentation Resources 62

9. Troubleshooting 63

Using the solaris_patch_installer 63

Installing the Forte for Java 4 IDE 64

Starting Up the Forte for Java 4 IDE 66

Running Web Services 68

Web Services Using UDDI 69

Using WebLogic 6.1 70

Using J2EE Reference Implementation 1.3.1 71

A. Solaris Patch Identifications and Descriptions 75

B. Port Usage in the Forte for Java 4 IDE 77
Contents v



vi Forte for Java 4, Enterprise Edition Getting Started Guide • June 2002



Before You Begin

This document provides installation instructions for the Forte™ for Java™ 4,

Enterprise Edition integrated development environment (IDE). Topics covered

include:

■ Overview of the installation steps

■ System requirements

■ Supported platforms

■ Installation of Java 2 Platform, Standard Edition (J2SE™), v. 1.4.0

■ Application servers with the IDE

■ Setting up databases with the IDE

■ Contents of top-level directories of the IDE

■ Registering with Forte for Java Developer Resources

■ Updating modules with the Update Center

■ Uninstalling the IDE

■ Using the startup command-line switches

■ Other documentation resources

This document instructs you to enter several commands at the command line.

Command lines vary slightly from one platform to another. For example, a Microsoft

Windows command might look like this:

To translate for UNIX® or Linux environments, simply change the prompt and use

forward slashes:

c:\> cd MyWorkDir\MyPackage

% cd MyWorkDir/MyPackage
vii



Before You Read This Book

Before you continue with the rest of this guide, you should be familiar with the

process of installing and uninstalling software products on the platforms you choose

to use with this release of the Forte for Java 4 product. You need familiarity with

some system administrative commands, such as:

■ patchadd , pkgadd , patchrm , and pkgrm utilities in the Solaris™ operating

environment

■ Add/Remove Program utility on Microsoft Windows systems

■ rpm command in the Red Hat Linux environment

If you are unfamiliar with or unsure about the system administrative commands for

your environment or system, contact your system administrator for assistance with

the instructions contained in this guide.

Note – Sun is not responsible for the availability of third-party web sites mentioned

in this document and does not endorse and is not responsible or liable for any

content, advertising, products, or other materials on or available from such sites or

resources. Sun will not be responsible or liable for any damage or loss caused or

alleged to be caused by or in connection with use of or reliance on any such content,

goods, or services available on or through any such sites or resources.

How This Book Is Organized

Chapter 1 gives an overview of the general installation process and information on

system requirements for Forte for Java 4, Enterprise Edition.

Chapter 2 provides instructions on installing and uninstalling the J2SE, v. 1.4.0

platform on your system.

Chapter 3 describes the steps to install the Forte for Java IDE on the supported

platforms. The subdirectories installed with the IDE are described and uninstallation

instructions are also provided.

Chapter 4 gives instructions on how to start and set up the newly installed Forte for

Java IDE. The command-line options are provided and information about product

registration is also included.
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Chapter 5 steps you through the validation of the Forte for Java IDE installation by

using a J2EE™ Reference Implementation 1.3.1 instance during the creation of a

simple HelloWorld application.

Chapter 6 provides some information for customizing your IDE installation using

the embedded PointBase Restricted Edition 4.2 database and the internal UDDI

registry server.

Chapter 7 gives information on integrating other application servers with the IDE.

Chapter 8 describes steps to update the IDE modules using the Forte for Java

Update Center. Information about other documentation resources are also included

in this chapter.

Chapter 9 provides you with some troubleshooting hints to assist you with problems

you might encounter during the installation and setup process.

Appendix A lists the patches for the Solaris 8 operating environment that are

included with the Solaris patch installer for the Solaris operating environment

(SPARC™ platform).

Appendix B lists the default port assignments used by the Forte for Java 4 modules,

third-party components, and application servers available for use with the IDE.

Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your.login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when contrasted

with on-screen computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

AaBbCc123 Command-line variable; replace

with a real name or value

To delete a file, type rm filename.
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Related Documentation

Forte for Java 4 documentation includes books delivered in Acrobat Reader (PDF)

format, online help, readme files of example applications, and Javadoc™

documentation.

Documentation Available Online

The documents in this section are available from the Forte for Java Developer

Resources (or Sun™ ONE Studio Developer Resources) portal and the

docs.sun.com SM web site.

The documentation link of the Forte for Java Developer Resources portal is at

http://forte.sun.com/ffj/documentation/ , or can be accessed by selecting

Documentation in the Help menu of the IDE. The docs.sun.com web site is at

http://docs.sun.com .

■ Release notes (HTML format)

Available for each Forte for Java 4 edition. Describe last-minute release changes

and technical notes.

■ Forte for Java 4, Community Edition Getting Started Guide (PDF format) -

part no. 816-4062-10

Forte for Java 4, Enterprise Edition Getting Started Guide (PDF format) -

part no. 816-4063-10

Available for each Forte for Java 4 edition. Describes how to install the Forte for

Java 4 product on each supported platform and includes other pertinent

information, such as system requirements, upgrade instructions, web server and

application server installation instructions, command-line switches, installed

subdirectories, Javadoc setup, database integration, and information on how to

use the Update Center.

■ The Forte for Java Programming Series (PDF format)

This series provides in-depth information on how to use various Forte for Java 4

features to develop well-formed applications for the Java 2 Platform, Enterprise

Edition (J2EE™).

■ Building Web Components - part no. 816-4337-10

Describes how to build a web application as a J2EE web module using

JavaServer Pages™ (JSP™) technology, servlets, tag libraries, and supporting

classes and files.
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■ Building J2EE Applications With Forte for Java - part no. 816-4061-10

Describes how to assemble Enterprise JavaBeans™ (EJB™) modules and web

modules into a J2EE application, and how to deploy and run a J2EE

application.

■ Building Enterprise JavaBeans Components - part no. 816-4060-10

Describes how to build EJB components—session beans and entity beans with

container-managed or bean-managed persistence—using the Forte for Java 4

EJB Builder wizard and other components of the IDE.

■ Building Web Services - part no. 816-4059-10

Describes how to use the Forte for Java 4 IDE to build web services, to make

web services available to others through a UDDI registry, and to generate web

service clients from a local web service or a UDDI registry.

■ Forte for Java 4 tutorials (PDF format)

You can also find the completed tutorial applications at

http://forte.sun.com/ffj/documentation/
tutorialsandexamples.html

■ Forte for Java 4, Community Edition Tutorial - part no. 816-4058-10

Provides step-by-step instructions for building a simple J2EE web application

using Forte for Java 4, Community Edition tools.

■ Forte for Java 4, Enterprise Edition Tutorial - part no. 816-4057-10

Provides step-by-step instructions for building an application using EJB

components and Web Services technology.

The docs.sun.com web site (http://docs.sun.com ) enables you to read, print,

and buy Sun Microsystems manuals through the Internet. If you cannot find a

manual, see the documentation index installed with the product on your local

system or network.

Online Help

Online help is available inside the Forte for Java 4 development environment. You

can access help by pressing the help key (Help in a Solaris environment, F1 on

Microsoft Windows and Linux), or by choosing Help → Contents. Either action

displays a list of help topics and a search facility.
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Examples

You can download several examples that illustrate a particular Forte for Java 4

feature, as well as completed tutorial applications from the Developer Resources

portal, at

http://forte.sun.com/ffj/documentation/tutorialsandexamples.html

Javadoc Documentation

Javadoc documentation is available within the IDE for many Forte for Java 4

modules. Refer to the release notes for instructions on installing this documentation.

When you start the IDE, you can access this Javadoc documentation within the

Javadoc pane of the Explorer.

Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and

suggestions. Email your comments to Sun at this address:

docfeedback@sun.com

Please include the part number (816-4063-10) of your document in the subject line of

your email.
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CHAPTER 1

Preparing for Installation

This chapter contains information needed to prepare for the installation of the Forte

for Java 4, Enterprise Edition IDE (hereafter referred to as “Forte for Java 4 IDE”).

Overview of the Installation

The following steps outline the general process of installing the Forte for Java 4 IDE

on your system. This process includes the validation, customization, and registration

of your Forte for Java 4 IDE installation:

1. Verify that you have local or network access to either the Java 2 Platform,

Standard Edition, v. 1.3.1 (hereafter referred to as “J2SE, v. 1.3.1 platform”) or the

Java 2 Platform, Standard Edition, v. 1.4.0 (hereafter referred to as “J2SE, v. 1.4.0

platform”) from the system in which you plan to install the Forte for Java 4 IDE.

Note – The recommended option is the J2SE, v. 1.4.0 platform with the Forte for

Java 4 IDE. Read Chapter 2 for detailed installation instructions.

2. Verify that the system on which you are installing the Forte for Java software

meets the minimum system requirements. See “System Requirements” on page 3

for more information.

3. Determine which software you want the Forte for Java 4 IDE installer to install.

The Forte for Java 4, Enterprise Edition installer includes the following software:

■ Core Platform and Modules (required)

■ PointBase Server 4.2 Restricted Edition

■ J2EE Reference Implementation 1.3.1

■ Solaris Developer Modules (available in Solaris operating environments only)
1



Note – The best option is to install the J2EE Reference Implementation 1.3.1 and the

PointBase Server 4.2 Restricted Edition with the IDE. These software products are

provided to enable you to quickly develop a simple J2EE application, as described in

Chapter 5.

4. Determine if you want to keep your previous version of the Forte for Java IDE. If

you do, identify a different directory in which to install Forte for Java 4,

Enterprise Edition.

If you want to use the same installation directory as the previous IDE version,

you must first uninstall the previous version of the IDE prior to installing Forte

for Java 4, Enterprise Edition.

5. Determine whether you want to keep your current Forte for Java IDE user

settings. If you decide to use your current user settings with the new IDE version,

you need to specify the location of your current user directory when prompted

during the initial IDE setup. Read Chapter 4 for more information.

6. Install Forte for Java 4, Enterprise Edition. Read Chapter 3 for detailed installation

instructions for each of the supported platforms.

7. Set up your initial IDE environment and register the product. Read Chapter 4 for

instructions on setting up your user directory and registering the product.

8. Validate your installation of the Forte for Java 4 IDE by starting an instance of the

J2EE Reference Implementation 1.3.1 server and creating a simple J2EE

application. Read Chapter 5 for additional information.

After you have validated that your Forte for Java 4 IDE installation is working

properly, perform the following steps, if desired:

1. Customize your Forte for Java 4 IDE installation by setting up the PointBase

database server. Refer to the instructions in Chapter 6.

2. Configure the use of other application servers with the Forte for Java 4 IDE. Read

Chapter 7 for configuration instructions.
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Supported Platforms

Forte for Java 4, Enterprise Edition has been tested with the following systems:

■ Microsoft Windows 2000 Professional system (with latest service packs)

■ Microsoft Windows XP

■ Red Hat Linux 7.2

■ Solaris 8 operating environment (64-bit, SPARC platform)

■ Solaris 9 operating environment (64-bit, SPARC platform)

This release has been tested on a limited basis on the following systems:

■ Microsoft Windows NT SP6 systems

■ Solaris 8 operating environment (32-bit, SPARC platform)

■ Solaris 9 operating environment (32-bit, SPARC platform)

System Requirements

TABLE 1-1 lists the system requirements needed to install a minimum configuration

on any of the supported platforms.

These are general guidelines. Your requirements might vary depending on which

additional software you have installed for use with the Forte for Java 4 IDE.

TABLE 1-1 Forte for Java 4, Enterprise Edition System Requirements

Supported Platforms
Free Hard Disk Space
Required for Installation Minimum Configuration

Windows 2000, Windows

XP, Windows NT4, SP61

1. This release has been tested on a limited basis on the Microsoft Windows NT4 SP6 systems and the Solaris 8
and Solaris 9 (32-bit, SPARC platform) environments.

180 MB Pentium III, 500 MHz, 512

MB RAM

Red Hat Linux 7.2 180 MB Pentium III 500 Mhz,

512 MB RAM

Solaris 8, Solaris 9 operating

environments (64-bit,

SPARC platform)

320 MB Ultra 60, 450 MHz, 512 MB

RAM

Solaris 8, Solaris 9 operating

environments (32-bit,

SPARC platform)1

320 MB Ultra 60, 450 MHz, 512 MB

RAM
Chapter 1 Preparing for Installation 3
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CHAPTER 2

Installing the J2SE, v. 1.4.0 Platform

This chapter gives instructions for verifying the version of the J2SE platform to

which you currently have access. If you need to install the J2SE, v. 1.4.0 platform on

your system, this chapter also gives step-by-step instructions for installing the

software on all the supported platforms. The J2SE, v. 1.4.0 platform includes the

Java 2 Software Development Kit, Standard Edition (Java 2 SDK) and the Java 2

Runtime Environment, Standard Edition (JRE).

Verifying Your J2SE Platform Version

To use the Forte for Java 4 IDE, you must have one of the following:

■ J2SE, v. 1.3.1 or J2SE, v. 1.4.0 platform installed on your system

■ Network access to the path in which v. 1.3.1 or v. 1.4.0 of the J2SE platform is

installed

If you run the Forte for Java 4 IDE without v. 1.3.1 or v. 1.4.0 of the J2SE platform

installed or available, you get error and warning messages. Version 1.4.0 is preferred.

Note – To maximize runtime performance, the J2SE platform should be installed on

and accessed from your local system.

Use the following steps to help you determine what you need to do next:

1. Identify which Java software is available to your system.

■ On a Microsoft Windows system, type the following in a command prompt

window:

C:\> java -version
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The output looks similar to the following:

■ In a Solaris or Linux environment, type the following:

The output looks similar to the following:

If you do not have v. 1.3.1 or v. 1.4.0 of the J2SE platform available to your system,

you must install the supported J2SE, v. 1.4.0 platform.

2. If you do not have v. 1.3.1 or v. 1.4.0 of the J2SE platform available to your system,
do the following:

a. Obtain the J2SE, v. 1.4.0 installer from
http://www.sun.com/software/sundev/jde/buy/index.html or from
the Forte for Java product CD.

b. Install the J2SE, v. 1.4.0 platform on your system.

Read the section following for additional instructions for your specific system.

3. (Solaris only) If the J2SE, v. 1.4.0 platform is already installed on your system,
install any Solaris patches that are applicable to your Solaris 8 operating
environment.

If you do not have the required Solaris patches when you start the Forte for Java 4

IDE, you receive a message that includes the Solaris patches you need to install on

your system. Install the patches on your system or contact your system

administrator before proceeding to use the Forte for Java 4 IDE.

The solaris_patch_installer , provided with the Forte for Java CD and also

available from the Forte for Java product download page, includes the Solaris patch

packages you need to install in your Solaris 8 operating environment.

C:\>java -version
java version "1.4.0"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.0-b92)
Java HotSpot(TM) Client VM (build 1.4.0-b92, mixed mode)

% java -version

% java -version
java version "1.4.0"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.0-b92)
Java HotSpot(TM) Client VM (build 1.4.0-b92, mixed mode)
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If you have previously installed the J2SE, v. 1.4.0 platform, you can use the

solaris_patch_installer to determine if all the necessary Solaris patches are

already installed in your system.

“Installing Patches in a Solaris 8 Operating Environment” on page 12 provides you

with instructions on how to use the solaris_patch_installer script.

Note – For a complete list of the Solaris patches included with the

solaris_patch_installer script, see Appendix A.

Installing the J2SE Platform on Microsoft
Windows Systems

Note – If you are unfamiliar with or unsure about installing the J2SE, v. 1.4.0

platform on your Microsoft Windows system, contact your system administrator for

assistance.

To install the J2SE, v. 1.4.0 platform on your supported Microsoft Windows system,

follow these steps:

1. If you have not already done so, download the j2sdk-1_4_0-win.exe installer
file from http://www.sun.com/software/sundev/jde/buy/index.html into
j2se-directory or locate the installer on the Forte for Java CD.

Note – Ensure that the j2se-directory, in which you download the software, is located

on a disk that has plenty of available space.

Use the following information if you are accessing the installer file from the

download page for the J2SE, v. 1.4.0 platform. Otherwise, proceed to Step 2.

a. In the “Before You Download” section of the
http://www.sun.com/software/sundev/jde/buy/index.html download
page, click “Java 2 Platform, Standard Edition, v. 1.4.0” to download the
installer file for the J2SE, v. 1.4.0 platform.

The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

The Java 2 Platform, Standard Edition download page is displayed.
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c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD
for Windows (all languages, including English).

The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms
of the license agreement.

You must agree to the license to continue with the download. Once you have

agreed to the license agreement, the download page is displayed.

e. Click Download j2sdk-1_4_0-win.exe to proceed with the download of the
file and specify where you want to save the file.

f. Verify that the size of the downloaded file is the same as the file size indicated
on the download page.

This step ensures that you have downloaded the full and uncorrupted software

bundle.

2. Uninstall any prerelease versions of the J2SE, v. 1.4.0 platform currently installed
on your system.

If you have previously installed a Beta release or the Release Candidate version of

the J2SE, v. 1.4.0 platform, uninstall it. Use the Microsoft Windows Add/Remove

Programs utility to uninstall the previous release of the J2SE, v. 1.4.0 platform.

Choose Start → Settings → Control Panel to access the utility.

3. Start the installation wizard by double-clicking the j2sdk-1_4_0-win.exe file
in the j2se-directory or from the Forte for Java product CD.

Note – You must have administrative permissions to install the J2SE, v. 1.4.0

platform in a Windows XP or Windows 2000 system.

4. Follow the instructions on the wizard panes to complete the J2SE, v. 1.4.0 platform
installation on your Microsoft Windows system.

5. (Optional) Delete the downloaded file from the j2se-directory to recover disk space.

Continue to Chapter 3 for instructions on installing the Forte for Java software.
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Installing the J2SE Platform in the Red
Hat Linux Environment

Note – If you are unfamiliar with or unsure about installing the J2SE, v. 1.4.0

platform in your Red Hat Linux environment, contact your system administrator for

assistance.

To install the J2SE, v. 1.4.0 platform in your supported Red Hat Linux environment,

follow these steps:

1. If you have not already done so, download the j2sdk-1_4_0-linux-i386-
rpm.bin file into j2se-directory or locate the file on the Forte for Java product CD.

Note – Ensure that the j2se-directory, in which you download the software, is located

on a disk that has plenty of available space.

Use the following information if you are accessing the installer file from the

download page for the J2SE, v. 1.4.0 platform. Otherwise, proceed to Step 2.

a. In the “Before You Download” section of the
http://www.sun.com/software/sundev/jde/buy/index.html download
page, click Java 2 Platform, Standard Edition, v. 1.4.0 to download the installer
file for the J2SE, v. 1.4.0 platform.

The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

The Java 2 Platform, Standard Edition download page is displayed.

c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD
for Linux Red Hat.

The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms
of the license agreement.

You must agree to the license to continue with the download. Once you have

agreed to the license agreement, the download page is displayed.

e. Click Download j2sdk-1_4_0-linux-i386-rpm.bin and specify the
directory, j2se-directory, where you want to save the file.
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f. Verify that the size of the downloaded file is the same as the file size indicated
on the download page.

This step ensures that you have downloaded the full and uncorrupted software

bundle.

2. Double-click the j2sdk-1_4_0-linux-i386-rpm.bin file on the Forte for Java
product CD or type the following commands:

The script displays the binary license agreement.

3. Read the binary license agreement carefully. To proceed, accept the terms of the
license agreement.

You must agree to the license to continue with the installation.

Once you have agreed to the license agreement, the install script creates the

j2sdk-1_4_0-linux-i386-rpm file in the current directory.

4. Become a superuser (root) by typing the following in a terminal window:

5. Uninstall any prerelease versions of the J2SE, v. 1.4.0 platform currently installed
on your system.

If you have previously installed a Beta release or the Release Candidate version of

the J2SE, v. 1.4.0 platform, uninstall it.

Note – The default installation location for the prerelease versions of the J2SE

platform is /usr/java/j2sdk1.4.0 . That is the same location in which the RPM

package of the final version of the J2SE, v. 1.4.0 platform is installed. To clear the

way for installation of the final version of the J2SE, v. 1.4.0 platform, you must first

uninstall any of these previous releases that you have installed. Skip this step if you

have not installed any of these previous releases.

If you are not sure if you have a prerelease version installed in your system, run the

following command:

$ cd j2se-directory
$ chmod a+x j2sdk-1_4_0-linux-i386-rpm.bin
$ j2sdk-1_4_0-linux-i386-rpm.bin

$ su
Password: root-password

# rpm -query -a | grep j2sdk-1.4.0
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The output displays the RPM package name of the prerelease version of the J2SE,

v. 1.4.0 platform. For example, if the J2SE 1.4.0 Beta 3 version is installed, the

command returns the RPM package name for Beta 3, which is j2sdk-1.4.0-
beta3 .

If you determine that a Beta package is installed, uninstall it using the rpm
command. For example, to remove the Beta 3 version of the J2SE, v. 1.4.0 platform,

type the following:

6. Run the rpm command to install the package for the J2SE, v. 1.4.0 platform by
typing the following:

The packages for the J2SE, v. 1.4.0 platform are installed in

/usr/java/j2sdk1.4.0 .

7. Exit from your superuser privileges by typing:

Continue to Chapter 3 for instructions on installing the Forte for Java software.

Installing the J2SE Platform in the Solaris
Operating Environment

You must first install any Solaris patches required in your Solaris 8 operating

environment (SPARC platform) before proceeding with the installation of the J2SE,

v. 1.4.0 platform. Use the steps in the next section to guide you in the installation of

the Solaris patches and the J2SE, v. 1.4.0 platform.

Note – The Solaris 9 environment is preconfigured with the J2SE, v. 1.4.0 platform.

It is not necessary to add the J2SE, v. 1.4.0 platform unless it was explicitly removed

from your Solaris 9 environment.

# rpm -e j2sdk-1.4.0-beta3

# cd j2se-directory
# rpm -iv j2sdk-1.4.0-linux-i386.rpm

# exit
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Installing Patches in a Solaris 8 Operating

Environment

Note – If you are unfamiliar with or unsure about installing Solaris patches in your

Solaris environment, contact your Solaris system administrator for assistance.

These instructions describe how to install the necessary Solaris patches prior to the

installation of the J2SE, v. 1.4.0 platform. These instructions are applicable only in a

Solaris 8 operating environment. Refer to Appendix A for a list of the Solaris patches

included with the solaris_patch_installer .

1. If you have not already done so, download the
solaris_patch_installer.tar.gz file into the solaris-patches-directory from
http://www.sun.com/software/sundev/jde/buy/index.html or from the
Forte for Java CD.

Note – Ensure that the solaris-patches-directory, in which you download the software,

is located on a disk that has plenty of available space.

2. From the solaris-patches-directory, uncompress and extract the contents of the
downloaded file by typing:

Note – The gzcat utility can be found in the /usr/bin directory in the Solaris 8

operating environment.

The solaris_patch_installer file and the patches directory are extracted in

the solaris-patches-directory. The patches directory contains several subdirectories

for each of the required Solaris patches.

3. (Optional) To recover disk space, remove the downloaded file by typing:

% cd solaris-patches-directory
% gzcat solaris_patch_installer.tar.gz  | tar xvf -

% rm -rf  solaris_patch_installer.tar.gz
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4. Become a superuser (root) by typing the following in a terminal window:

5. Go to the solaris-patches-directory and run the solaris_patch_installer script:

The solaris_patch_installer determines which patches needed for the

installation of the J2SE, v. 1.4.0 platform have already been applied and which

patches still need to be installed.

You see output similar to the following:

6. (Optional) After the patch installation is complete, look at the
/var/tmp/solaris_patch_installer.log file for more details about the
installation.

Note – Some Solaris patches require that you reboot your system after installation

has completed. The installer prompts you to reboot, if necessary.

7. When prompted, reboot your system by typing y :

% su
Password: root-password

# cd solaris-patches-directory
# ./solaris_patch_installer

# ./solaris_patch_installer
Solaris Patch Installer for J2SE, v.1.4.0
Installing 109147-14...already applied

Installing 108434-06...successfully installed

Installing 108435-06...successfully installed

Installing 111293-04...attempting to patch a package that is not
installed

Installing 112334-01...already applied

# Certain patches installed on your system require that you reboot
your machine.
Do you want to REBOOT your machine now? (y/n)
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8. If you are not prompted to reboot, exit from your superuser privileges by typing:

9. (Optional) After you log back on to your system, remove the solaris-patches-directory
and its contents to recover disk space. Type the following:

Installing the J2SE, v. 1.4.0 Platform in a Solaris 8

Environment

Note – If you are unfamiliar with or unsure about installing Solaris packages or the

J2SE, v. 1.4.0 platform in your Solaris environment, contact your Solaris system

administrator for assistance.

Prior to installing the J2SE, v. 1.4.0 platform, you must ensure that you have installed

the full set of required patches needed to support v. 1.4.0 of the J2SE platform in

your Solaris 8 environment. See “Installing Patches in a Solaris 8 Operating

Environment” on page 12 for more information.

To install the 64-bit J2SE, v. 1.4.0 platform in your 64-bit Solaris 8 environment, you

must follow a two-step procedure:

1. Install the 32-bit J2SE, v. 1.4.0 platform in your 64-bit Solaris 8 environment.

Use the instructions in “Installing the J2SE, v. 1.4.0 Platform in a 32-bit Solaris 8

Environment” on page 15 for more information.

2. Install the J2SE, v. 1.4.0 supplemental release for 64-bit operation in your 64-bit
Solaris 8 environment.

Use the instructions in “Installing the J2SE, v. 1.4.0 Supplemental Release for 64-bit

Operation in a Solaris 8 Environment” on page 18 for more information.

# exit

% rm -rf solaris-patches-directory
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Installing the J2SE, v. 1.4.0 Platform in a 32-bit Solaris 8
Environment

Note – If you are unfamiliar with or unsure about installing Solaris packages or the

J2SE, v. 1.4.0 platform in your Solaris environment, contact your Solaris system

administrator for assistance.

Follow these steps to install the J2SE, v. 1.4.0 platform in your supported Solaris

operating environment using the pkgadd command:

1. If you have not already done so, download the j2sdk-1_4_0-solsparc.tar.Z
file into the j2se-directory. You can also obtain the file from the Forte for Java
product CD.

Note – Ensure that the j2se-directory, in which you download the software, is located

on a disk that has plenty of available space.

If you are accessing the installer file from the Forte for Java product CD, skip to

Step e.

a. In the “Before You Download” section of the
http://www.sun.com/software/sundev/jde/buy/index.html download
page, click Java 2 Platform, Standard Edition, v. 1.4.0 to download the installer
file for the J2SE, v. 1.4.0 platform.

The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

The Java 2 Platform, Standard Edition download page is displayed.

c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD
for Solaris SPARC 32-bit tar.Z.

The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms
of the license agreement.

You must agree to the license to continue with the download. Once you have

agreed to the license agreement, the download page is displayed.

e. Click Download j2sdk-1_4_0-solsparc.tar.Z from the product download
page or obtain the file from the Forte for Java product CD, and save the file to
the j2se-directory.
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f. Verify that the size of the downloaded file is the same as the file size indicated
on the download page or from the Forte for Java product CD.

This ensures that you have downloaded the full and uncorrupted software

bundle.

2. From the j2se-directory, uncompress and extract the contents of the downloaded
installer file by typing the following at the command line:

This action creates several packages (SUNWj3dmo, SUNWj3dev, SUNWj3man,
SUNWj3rt , plus SUNWj3jmp for Japanese man pages) along with the product

license, readme file, and other release documentation.

3. Become a superuser (root) by typing the following in a terminal window:

4. Uninstall your previous installation of the J2SE platform, if needed.

Note – The default installation location for versions 1.3.0, 1.3.1, and the previous

1.4.0 Beta release of the J2SE platform is /usr/j2se . That is the same location in

which J2SE, v. 1.4.0 is installed. To clear the way for installation of the J2SE, v. 1.4.0

platform, you must first uninstall any of these previous releases that you have

installed. Skip this step if you have not installed any of these previous releases or if

you intend to install J2SE, v. 1.4.0 in a nondefault location.

If you have previously installed the packages for J2SE versions 1.3.0, 1.3.1, or 1.4.0

prereleases, remove them by using the pkgrm command:

If you have previously installed packages SUNWlj3dv and SUNWlj3rt for

localization support in version 1.3.0, remove them by using the following command:

% cd j2se-directory
% zcat j2sdk-1_4_0-solsparc.tar.Z  | tar xvf -

% su
Password: root-password

# pkgrm SUNWj3dmo SUNWj3man SUNWj3dev SUNWj3rt

# pkgrm SUNWlj3dv SUNWlj3rt
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If you have previously installed the Japanese man page packages for the Java 2 SDK

v. 1.3.0 or v. 1.3.1, remove them by using the following command:

If your /usr/java symbolic link was pointing to the Java 2 SDK v. 1.2.2 installation

at /usr/java1.2 , you might want to update it to point to /usr/j2se, which is the

location where the Java 2 SDK v. 1.4.0 will be installed.

5. Run the pkgadd command to install the packages:

The J2SE v. 1.4.0 packages are installed into /usr/j2se . Refer to the pkgadd(1)
and admin(4) man pages for information on installing the J2SE, v. 1.4.0 in a

nondefault location.

6. (Optional) Remove the j2se-directory to recover disk space:

7. Exit from your superuser privileges by typing:

If you need to install the J2SE, v. 1.4.0 supplemental release platform, continue to

“Installing the J2SE, v. 1.4.0 Supplemental Release for 64-bit Operation in a Solaris 8

Environment” on page 18 for more information.

Otherwise, continue to Chapter 3 for instructions on installing the Forte for Java

software.

# pkgrm SUNWjej3m SUNWjpj3m SUNWjuj3m

# cd j2se-directory
# pkgadd -d . SUNWj3rt SUNWj3dev SUNWj3man SUNWj3dmo

# rm -rf j2se-directory

# exit
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Installing the J2SE, v. 1.4.0 Supplemental Release for 64-bit
Operation in a Solaris 8 Environment

Note – If you are unfamiliar with or unsure about installing Solaris packages or the

J2SE, v. 1.4.0 platform in your Solaris environment, contact your Solaris system

administrator for assistance.

Follow these steps to install the 64-bit supplemental release of the J2SE, v. 1.4.0

platform in your Solaris 8 environment:

1. If you have not already done so, download the j2sdk-1_4_0-
solsparcv9.tar.Z file into the j2se-64bit-directory. You can also obtain the file
from the Forte for Java product CD.

Note – Ensure that the jse-64bit-directory, in which you download the software, is

located on a disk that has plenty of available space.

If you are accessing the installer file from the Forte for Java product CD, skip to

Step e.

a. In the “Before You Download” section of the
http://www.sun.com/software/sundev/jde/buy/index.html download
page, click Java 2 Platform, Standard Edition, v. 1.4.0 to download the installer
file for the J2SE, v. 1.4.0 platform.

The Java 2 Platform, Standard Edition, v. 1.4.0 Overview page is displayed.

b. Click “Download J2SE v. 1.4 Now!”

The Java 2 Platform, Standard Edition download page is displayed.

c. From the SDK column of the Download J2SE, v. 1.4.0 table, click DOWNLOAD
for Solaris SPARC 64-bit tar.Z.

The binary code license agreement is displayed.

d. Read the binary code license agreement carefully. To proceed, accept the terms
of the license agreement.

You must agree to the license to continue with the download. Once you have

agreed to the license agreement, the download page is displayed.

e. Click Download j2sdk-1_4_0-solsparcv9.tar.Z from the product
download page or obtain the file from the Forte for Java product CD, and
specify where you want to save the file.
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f. Verify that the size of the downloaded file is the same as the file size indicated
on the download page.

This step ensures that you have downloaded the full and uncorrupted software

bundle.

2. From the j2se-64bit-directory, uncompress and extract the contents of the
downloaded installer file by typing the following at the command line:

This action creates several packages (SUNWj3dvx, SUNWj3rtx , and SUNWj3dmx)
that contain 64-bit support for the J2SE, v. 1.4.0 platform.

3. Become a superuser (root) by typing the following in a terminal window:

4. Uninstall your Beta installation of the 64-bit packages for the J2SE, v.1.4.0, if
needed.

If you have previously installed the Beta release of packages SUNWj3dvx,

SUNWj3rtx , and SUNWj3dmxfor 64-bit support, remove them using the pkgrm
command:

5. Run the pkgadd command to install the packages:

This action installs the files for 64-bit support into the J2SE v. 1.4.0 installation at

/usr/j2se .

6. (Optional) Remove the j2se-64bit-directory to recover disk space:

% cd j2se-64bit-directory
% zcat j2sdk-1_4_0-solsparcv9.tar.Z  | tar xvf -

% su
Password: root-password

# pkgrm SUNWj3rtx SUNWj3dvx SUNWj3dbx

# cd j2se-64bit-directory
# pkgadd -d . SUNWj3rtx SUNWj3dvx SUNWj3dmx

# rm -rf j2se-64bit-directory
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7. Exit from your superuser privileges by typing:

Continue to Chapter 3 for instructions on installing the Forte for Java software.

Uninstalling the J2SE, v. 1.4.0 Platform

Use the following information to uninstall the J2SE, v. 1.4.0 platform:

■ In a Microsoft Windows system, use the Add/Remove Programs utility in the

Control Panel to uninstall the J2SE, v. 1.4.0 platform from your system.

■ For a Red Hat Linux environment, use the rpm command to uninstall the J2SE,

v. 1.4.0 platform from your system.

■ For Solaris operating environments, use the pkgrm and patchrm commands to

uninstall the J2SE, v. 1.4.0 platform and associated Solaris patches from your

system.

Caution – Removing the J2SE, v. 1.4.0 software and related Solaris patches can

cause regressive behavior on your system. Contact your Solaris system administrator

if you are unfamiliar with or unsure of how to remove the Solaris, v. 1.4.0 platform

and associated Solaris patches from your system.

Refer to the pkgrm and patchrm man pages for additional information on these

commands.

# exit
20 Forte for Java 4, Enterprise Edition Getting Started Guide • June 2002



CHAPTER 3

Installing the Forte for Java 4 IDE

This chapter contains information on how to install Forte for Java 4, Enterprise

Edition on each of the supported platforms. The subdirectories installed with the

IDE are described and uninstallation instructions are also provided.

Supporting Previous Forte for Java
Software Releases

To upgrade your previous version of the IDE to Forte for Java 4 software, you must

do one of the following:

■ Determine if you want to keep your previous version of the IDE. If you do,

identify a different directory in which to install the Forte for Java 4 software.

If you want to use the same installation directory as the previous IDE version,

you must first uninstall the previous version of the IDE prior to installing Forte

for Java 4 software.

■ Determine whether you want to keep your current IDE user settings. If you

decide to use your current user settings with the new IDE version, you need to

specify the location of your current user directory when prompted during the

initial IDE setup. Read Chapter 4 for more information.
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Creating a Shared Installation

If you want to share a Forte for Java installation between multiple users, you must

install the Forte for Java 4 IDE into a shared directory.

After installation of the IDE in the supported Solaris environment or Red Hat Linux

environment, all user settings are stored in the ffjuser40ee directory created

under each user’s home directory. This occurs for both shared and unshared

installations.

After installation of the IDE in a Microsoft Windows system, you must set your own

user directory using a dialog box that appears immediately upon initial startup of

the IDE from your machine. This occurs for both shared and unshared installations.

The recommended name for the user directory in a Microsoft Windows system is

drive:fully-qualified-path\ffjuser40ee . This name is entered as the UserDir value

of the Software\SunMicrosystems, Inc.\Forte for Java key in the

HKEY_CURRENT_USERregistry. This value is not deleted when the IDE is

uninstalled. If the UserDir value is not explicitly deleted from the Microsoft

Windows Registry, it will be reused by future installations of this version of the IDE.

Refer to some troubleshooting information in Chapter 9, if you want to use a

different location for your user directory.

Installing the Forte for Java 4 IDE on the
Supported Platforms

These instructions describe the installation process for each of the supported

platforms.

Installation on Microsoft Windows Systems

You can install the Forte for Java 4 IDE on a supported Microsoft Windows system

through an .exe file.
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Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed

on your system before installing the Forte for Java 4 IDE. The recommended option

is the J2SE, v. 1.4.0 platform with the Forte for Java 4 IDE. Read Chapter 2 for

instructions on installing the software.

1. If you have not already done so, download the ffj_ee_win32_en.exe installer
file from http://www.sun.com/software/sundev/jde/buy/index.html or
locate the file on the Forte for Java 4 product CD.

If you are downloading the file from the product download page, do the following:

a. Save it into the ffj-download-directory.

b. Write down the serial number provided to you on the download page.

If you are accessing the file from the Forte for Java 4 product CD, locate the serial

number in the Forte for Java 4 product package.

2. Double-click the ffj_ee_win32_en.exe file in the ffj-download-directory or on the
Forte for Java 4 product CD.

The InstallShield’s Welcome screen appears.

Note – If you encounter errors at any point during the Forte for Java 4 IDE

installation, refer to Chapter 9 for some troubleshooting hints.

3. In the Welcome screen, click Next.

4. Read the license agreement carefully. To proceed, accept the terms of the license
agreement, and click Next.

You must agree to the license to continue with the installation.

InstallShield attempts to locate a compatible Java 2 SDK v. 1.3.1 or v. 1.4.0 on your

system.

5. Set the location of compatible Java 2 SDK software and click Next.

The Forte for Java 4 IDE requires local or network access to either v. 1.3.1 or v. 1.4.0

of the Java 2 SDK software. Specify which installed software to use by doing one of

the following:

■ Accept the default location.

■ Select another location from the list of found Java 2 SDK software.

■ Click Browse to specify a different location.

Click Next after you have set the Java 2 SDK location.
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6. Type the serial number provided with the product CD or available from the
product download page. Alternatively, click Next without entering a serial
number to generate a trial serial number.

a. Click Yes to automatically generate a trial serial number.

The trial serial number expires in 60 days.

b. Write down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you

have registered the product. Read Chapter 4 for product registration information

and “Updating Modules With the Update Center” on page 61 for information on

the Forte for Java Update Center.

c. Click Next a second time to continue with the installation.

7. Accept the default installation folder or click Browse to install the IDE in a
different folder. Click Next to continue.

Note – The installation directory name cannot contain any spaces and it must be an

empty or new directory.

8. Select the Forte for Java 4 components you want to install.

The following components are available:

■ Core Platform and Modules (required)

■ PointBase Server 4.2 Restricted Edition

■ Java 2 Platform, Enterprise Edition (J2EE) Reference Implementation 1.3.1

Note – The best option is to install the J2EE Reference Implementation 1.3.1 and the

PointBase Server 4.2 Restricted Edition with the IDE. These software products are

provided to enable you to quickly develop a simple J2EE application, as described in

Chapter 5.

9. Confirm your installation choices in the installation summary dialog box and click
Next.

InstallShield installs the Forte for Java 4 components you have selected.

10. Decide whether you want to associate .java and .nbm files with the Forte for
Java 4 IDE. Click Next to continue.

If you decide to associate these file types, the Forte for Java 4 IDE will automatically

launch when you open these files.

11. Click Finish to complete the installation.
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12. Review the Release Notes file for important information regarding the release.
You can access the Release Notes from the product CD or from
http://forte.sun.com/ffj/documentation/index.html .

13. Continue to Chapter 4 for information on setting up the Forte for Java 4 IDE.

Installation in the Red Hat Linux Environment

You can install the Forte for Java 4 IDE in a supported Red Hat Linux environment

with a .bin file.

Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed

on your system before installing the Forte for Java 4 IDE. The recommended option

is the J2SE, v. 1.4.0 platform with the Forte for Java 4 IDE. Read Chapter 2 for

instructions on installing the software.

1. If you have not already done so, download the ffj_ee_linux_en.bin installer
file from http://www.sun.com/software/sundev/jde/buy/index.html or
locate the file on the Forte for Java 4 product CD.

If you are downloading the file from the product download page, do the following:

a. Save it into the ffj-download-directory.

b. Write down the serial number provided to you on the download page.

If you are accessing the file from the Forte for Java 4 product CD, locate the serial

number in the Forte for Java 4 product package.

2. Set the DISPLAY environment variable to display to your local system.

If you are installing to your local system, the DISPLAY environment variable should

be set to :0.0 . If you are using a superuser (root) account or are doing a remote

installation, set your superuser session’s DISPLAY environment variable to display

to your local system.

For example, to set the variable from a root account running C-shell, type the

following in your superuser session command prompt:

# setenv DISPLAY your-local-system: 0.0
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3. Set the execute permission on the ffj_ee_linux_en.bin file and execute it by
double-clicking the file from the Forte for Java 4 product CD or by typing the
following:

Note – If you encounter errors at any point during the Forte for Java 4 IDE

installation, refer to Chapter 9 for some troubleshooting hints.

4. In the Welcome screen, click Next.

5. Read the license agreement carefully. To proceed, accept the terms of the license
agreement, and click Next.

You must agree to the license to continue with the installation.

InstallShield attempts to locate a compatible Java 2 SDK v. 1.3.1 or v. 1.4.0 on your

system.

6. Set the location of compatible Java 2 SDK software and click Next.

The Forte for Java 4 IDE requires local or network access to either v. 1.3.1 software or

v. 1.4.0 of the Java 2 SDK software. Specify which installed software to use by doing

one of the following:

■ Accept the default location.

■ Select another location from the list of found Java 2 SDK software.

■ Click Browse to specify a different location.

Click Next after you have set the Java 2 SDK location.

7. Type the serial number provided with the product CD or available from the
product download page. Alternatively, click Next without entering a serial
number to generate a trial serial number.

a. Click Yes to automatically generate a trial serial number.

The trial serial number expires in 60 days.

b. Write down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you

have registered the product. Read Chapter 4 for product registration information

and “Updating Modules With the Update Center” on page 61 for information on

the Forte for Java Update Center.

c. Click Next a second time to continue with the installation.

$ cd ffj-download-directory
$ chmod a+x ffj_ee_linux_en.bin
$ ffj_ee_linux_en.bin
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8. Accept the default installation directory or click Browse to install the IDE in a
different directory. Click Next to continue.

Note – The installation directory name cannot contain any spaces and it must be an

empty or new directory.

9. Select the Forte for Java 4 components you want to install.

The following components are available:

■ Core Platform and Modules (required)

■ PointBase Server 4.2 Restricted Edition

■ Java 2 Platform, Enterprise Edition (J2EE) Reference Implementation 1.3.1

Note – The best option is to install the J2EE Reference Implementation 1.3.1 and the

PointBase Server 4.2 Restricted Edition with the IDE. These software products are

provided to enable you to quickly develop a simple J2EE application, as described in

Chapter 5.

10. Confirm your installation choices in the installation summary dialog box and click
Next.

InstallShield installs the Forte for Java 4 components you have selected.

11. Click Finish to complete the installation.

12. Review the Release Notes file for important information regarding the release.
You can access the Release Notes from the product CD or from
http://forte.sun.com/ffj/documentation/index.html .

13. Continue to Chapter 4 for information on setting up the Forte for Java 4 IDE.

Installation in the Solaris Operating Environments

You can install the Forte for Java 4 IDE in a supported Solaris operating environment

with a .bin file.

Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed

on your system before installing the Forte for Java 4 IDE. The recommended option

is the J2SE, v. 1.4.0 platform with the Forte for Java 4 IDE. Read Chapter 2 for

instructions on installing the software.
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1. If you have not already done so, download the ffj_ee_solsparc_en.bin
installer file from
http://www.sun.com/software/sundev/jde/buy/index.html or locate it on
the Forte for Java 4 product CD.

If you are downloading the file from the product download page, do the following:

a. Save it into the ffj-download-directory.

b. Write down the serial number provided to you on the download page.

If you are accessing the file from the Forte for Java 4 product CD, locate the serial

number in the Forte for Java 4 product package.

2. Set the DISPLAY environment variable to display to your local system.

If you are installing to your local system, the DISPLAY environment variable should

be set to :0.0 . If you are using a superuser (root) account or are doing a remote

installation, set your superuser session’s DISPLAY environment variable to display

to your local system.

For example, to set the variable from a root account running C-shell, type the

following in your superuser session command prompt:

3. Set the execute permission on the ffj_ee_solsparc_en.bin file and execute it
by double-clicking the file from the Forte for Java 4 product CD or by typing the
following:

Note – If you encounter errors at any point during the Forte for Java 4 IDE

installation, refer to Chapter 9 for some troubleshooting hints.

4. In the InstallShield’s Welcome screen, click Next.

5. Read the license agreement carefully. To proceed, accept the terms of the license
agreement, and click Next.

You must agree to the license to continue with the installation.

InstallShield attempts to locate a compatible Java 2 SDK v. 1.3.1 or v. 1.4.0 on your

system.

# setenv DISPLAY your-local-system: 0.0

$ cd ffj-download-directory
$ chmod a+x ffj_ee_solsparc_en.bin
$ ffj_ee_solsparc_en.bin
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6. Set the location of compatible Java 2 SDK software and click Next.

The Forte for Java 4 IDE requires local or network access to either v. 1.3.1 or v. 1.4.0

of the Java 2 SDK software. Specify which installed Java 2 SDK software to use by

doing one of the following:

■ Accept the default location.

■ Select another location from the list of found Java 2 SDK software.

■ Click Browse to specify a different location.

Click Next after you have set the Java 2 SDK location.

7. Type the serial number provided with the product CD or available from the
product download page. Alternatively, click Next without entering a serial
number to generate a trial serial number.

a. Click Yes to automatically generate a trial serial number.

The trial serial number expires in 60 days.

b. Write down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you

have registered the product. Read Chapter 4 for product registration information

and “Updating Modules With the Update Center” on page 61 for information on

the Forte for Java Update Center.

c. Click Next a second time to continue with the installation.

8. Accept the default installation folder or click Browse to install the IDE in a
different directory. Click Next to continue.

Note – The installation directory name cannot contain any spaces and it must be an

empty or new directory.

9. Select the Forte for Java 4 components you want to install.

The following components are available:

■ Core Platform and Modules (required)

■ PointBase Server 4.2 Restricted Edition

■ Java 2 Platform, Enterprise Edition (J2EE) Reference Implementation 1.3.1

■ Solaris Developer Modules

Note – The best option is to install the J2EE Reference Implementation 1.3.1 and the

PointBase Server 4.2 Restricted Edition with the IDE. These software products are

provided to enable you to quickly develop a simple J2EE application, as described in

Chapter 5.
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10. If you chose to install the Solaris Developer Modules, specify the path to the Forte
Compiler Collection (FCC).

If you are installing the IDE on a server that will be accessed by multiple users, the

path name specified for the FCC software must be valid and accessible to all those

IDE users.

If you have not installed the Forte Compiler Collection or you do not readily know

the path to the Forte Compiler Collection, leave the FCC Path blank and click Next.

The Forte Compiler Collection software refers to an installation of Forte Developer 7

software and you can download it from

http://www.sun.com/software/sundev/suncc/buy/ .

You can set or reset the FCC path at a later time by using the forte_fcc utility,

which can be found in ffj-install-dir/bin/forte_fcc . Read the forte_fcc man

page at ffj-install-dir/man/man1 for additional information.

11. Confirm your installation choices in the installation summary pane and click
Next.

InstallShield installs the Forte for Java 4 components you selected.

12. Click Finish to complete the installation.

13. Review the Release Notes file for important information regarding the release.
You can access the Release Notes from the product CD or from
http://forte.sun.com/ffj/documentation/index.html .

14. Continue to Chapter 4 for information on setting up the Forte for Java 4 IDE.
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Installing the IDE Using the Command-
line Options

If you prefer to install the Forte for Java 4 IDE using the command line, use the

following steps to guide you. You need to create a file called installer.sp and add to

the file the command-line options you want to use to install the IDE.

1. If you have not already done so, download the installer file for your supported
platform from
http://www.sun.com/software/sundev/jde/buy/index.html or locate the
file on the Forte for Java 4 product CD.

a. Save the installer file into the ffj-download-directory.

On a Microsoft Windows systems, download the ffj_ee_win32_en.exe file. In

a Solaris environment, download the ffj_ee_solsparc_en.bin file. In a

Red Hat Linux environment, download the ffj_ee_linux_en.bin file.

b. Write down the serial number provided to you on the download page or locate
the serial number in the Forte for Java 4 product package, if you are using the
product CD.

2. Create an installer.sp file in the ffj-download-directory.

The IDE installer will read the command-line options you include in the installer.sp
file.

On a Microsoft Windows system, create a file called ffj_ee_win32_en.sp and

place the file in the ffj-download-directory.

For the Solaris and Linux environments, name the file ffj_ee_solsparc_en.sp
and ffj_ee_linux_en.sp , respectively.
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3. Determine the command-line options and corresponding values you want to use,
and include them in the installer.sp file.

TABLE 3-1 lists the different command-line options and their default values, if any.

You can use either the long or short name for each option.

TABLE 3-1 Forte for Java 4 Command-line Installation Options

Installation Options Description

fortehome= ffj-install-dir
fh= ffj-install-dir

Specifies the directory into which you want the IDE installed. This is a

mandatory command-line parameter for the -silent mode.

jdkhome= jdkhome-dir
jh= jdkhome-dir

Sets the location of the valid Java 2 SDK version to use with the IDE.

The installer will configure the IDE to use this Java 2 SDK software.

This is a mandatory command-line parameter for the -silent mode.

serialnumber= serial-number
serialnumber=trial

sn= serial-number
sn=trial

Sets the serial number for the IDE. Use the serial number you received

when you downloaded the Forte for Java 4 IDE installer software, or

the one included with the Forte for Java 4 product package. You may

also specify the value trial to generate a temporary license that will

expire after 60 day. This is a mandatory command-line parameter for

the -silent mode.

pointbaseinstall=yes

pointbaseinstall=no

pi=yes

pi=no

Specifies whether to install the PointBase Server 4.1 Network Edition.

The default value is yes .

j2eeinstall=yes

j2eeinstall=no

ji=yes

ji=no

Specifies whether to install the J2EE Reference Implementation 1.3.1.

The default value is yes .

fccHome= FCC_path
fch= FCC_path

(Solaris only) Sets the path to the directory where the Forte Compiler

Collection (FCC) is installed. This option is valid only on a supported

Solaris environment.

si=yes

si=no

soldevInstall=yes

soldevInstall=no

(Solaris only) Specifies whether to install the Solaris Developer

Modules. The default value is yes . This option is valid only on

supported Solaris environments.

-silent Specify this option on the command line and not in the installer.sp
file. If not specified, the Installshield wizard will appear. If specified,

any error messages will be displayed on the command window from

which the installer was invoked.
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For example, on a Microsoft Windows system, the ffj_ee_win32_en.sp might

have the following contents:

On a Solaris environment, the ffj_ee_solsparc_en.sp might have the following

contents:

4. Invoke the installer from the command line.

For example, on a Microsoft Windows system, type the following in a command

prompt window:

In a Solaris environment, type the following in a terminal window, for example:

fh=C:\forte4j
jh=C:\j2sdk1.4.0
sn=trial
pi=yes
ji=yes

fh=/yourserver/forte4j
jh=/usr/j2se
sn=trial
pi=yes
ji=yes
si=yes
fch=/yourserver/fcc

C:\> cd ffj-download-directory
C:\ ffj-download-directory> ffj_ee_win32_en.exe -silent

$ cd ffj-download-directory
$ ffj_ee_solsparc_en.bin -silent
Chapter 3 Installing the Forte for Java 4 IDE 33



The installer uses the options you have specified in the installer.sp file for your

system and displays the following on the command prompt window:

If there are any errors encountered, messages are displayed on the command prompt

window.

Note – If you encounter errors at any point during the Forte for Java 4 IDE

installation, refer to Chapter 9 for some troubleshooting hints.

5. Continue to Chapter 4 for information on setting up the Forte for Java 4 IDE.

Finding Installation Subdirectories

After you have installed the Forte for Java 4 IDE, the subdirectories listed in

TABLE 3-2 can be found under ffj-install-dir, your Forte for Java 4 installation directory.

InstallShield Wizard

Initializing InstallShield Wizard...

Searching for Java(tm) Virtual Machine...
.........
Running InstallShield Wizard...

TABLE 3-2 Forte for Java Installation Subdirectories

Subdirectory Name Description

LICENSE.html Contains the Sun Microsystems, Inc. binary code license

agreement.

/_uninst Contains the files used to uninstall in the IDE.

/beans Contains JavaBeans components installed in the IDE.

/bin Includes the Forte for Java startup scripts (as well as the ide.cfg
file in Microsoft Windows installations).

(Solaris only) Also contains launch points for the standalone

applications delivered with the Solaris tools, including xemacs ,

gvim , xdesigner , and forte_fcc .

/docs Contains the Forte for Java help files and other miscellaneous

documentation.
34 Forte for Java 4, Enterprise Edition Getting Started Guide • June 2002



/emacs (Solaris only) Contains emacs files.

/examples Contains source files for examples that illustrate several key

features of the Forte for Java 4, Enterprise Edition.

/j2sdkee1.3.1 Contains the J2EE Reference Implementation v. 1.3.1 files, if you

chose to install those files during the Forte for Java installation

process.

/jwsdp Contains files and directories specific to the Java Web Services

Developer Pack.

/lib Contains the JAR files that make up the IDE’s core implementation

and the open APIs.

/man (Solaris only) Contains man pages for Solaris Developer Modules,

if installed.

/modules Stores Forte for Java modules as JAR files.

/platform (Solaris only) Contains platform-specific files.

/pointbase Contains four subdirectories, client , databases , docs , and

server . The client directory contains the PointBase console,

command-line utilities, and examples of a PointBase application.

The databases directory contains a sample database. The docs
directory contains PointBase documentation. The server directory

contains the PointBase server.

/sources Contains sources for libraries that might be redistributed with user

applications.

/system Includes files and directories used by the IDE for special purposes.

Go to your individual ffj-user-dir/system directory to get the

ide.log , which provides information useful when requesting

technical support, and to view project.basic and

project.last files, which contain information on Forte for Java

projects. On a Microsoft Windows system, this ffj-user-dir/system
directory contains the project-specific files under

project.basic_hidden and project.last files.

/tomcat401 Contains Tomcat-specific files.

update_tracking.xml Contains information used by the AutoUpdate Center.

TABLE 3-2 Forte for Java Installation Subdirectories (Continued)

Subdirectory Name Description
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Uninstalling the Forte for Java 4 IDE

An uninstaller wizard is available to assist you in the uninstallation of the Forte for

Java 4 IDE. Follow these steps to uninstall your copy of the Forte for Java 4 IDE:

1. Start the uninstaller from the ffj-install-dir/_uninst directory.

■ In a supported Solaris operating environment or Red Hat Linux environment,

ensure that your DISPLAY environment variable is defined correctly, and then

type:

■ On a Microsoft Windows system, execute the uninstaller.exe file located in

the ffj-install-dir/_uninst directory or use the Add/Remove Program utility in

the Control Panel.

The uninstaller’s Welcome screen appears.

2. Click Next from the Welcome screen.

A list of Forte for Java components is displayed.

3. Select the components you want to uninstall and click Next.

4. Click Next to confirm the components to be uninstalled.

The uninstaller wizard proceeds with the uninstallation of the IDE.

5. Click Finish to close the uninstaller wizard.

$ java -jar uninstall.jar
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CHAPTER 4

Using Your Newly Installed Forte
for Java 4 IDE

After you have successfully installed the Forte for Java 4 IDE, use the information in

this chapter to launch, set up, and register your Forte for Java 4 IDE. Details about

the available command-line switch options are also included.

Setting Up Your Forte for Java 4 IDE

When you first start up the Forte for Java 4 IDE, you are prompted to:

■ Register your software

■ Specify the user directory to use with the IDE

■ Indicate whether you would like automatic update checking

Use the following steps to guide you through setup of your initial IDE environment:

1. Start the Forte for Java 4 IDE.

■ For the supported Solaris operating environments or a Red Hat Linux

environment, type:

$ cd ffj-install-dir/bin
$ runide.sh
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■ For a Microsoft Windows system, double-click the Forte for Java 4.0 EE icon

created on your desktop or click the Start menu and choose

Forte for Java 4.0 EE → Forte for Java. Alternatively, from a command prompt

window, type:

If this is the first time you are installing this version of the Forte for Java 4 IDE on

a Microsoft Windows system, you are prompted for the user directory.

2. On a Microsoft Windows system, type the name of the directory where you want
the IDE to store your settings and project information, and click OK.

Ensure that the directory you choose is in a place that is always accessible to your

system. If you have different versions of the IDE, use a different user directory for

each IDE version. This directory should be different than the directory where the

IDE is installed.

The recommended name for the user directory in a Microsoft Windows system is

drive:fully-qualified-path\ffjuser40ee . This name is entered as the UserDir value

of the Software\SunMicrosystems, Inc.\Forte for Java key in the

HKEY_CURRENT_USERregistry. This value is not deleted when the IDE is

uninstalled. The name will be reused by future installations of this version of the

IDE if the UserDir value is not explicitly deleted from the Microsoft Windows

Registry. Refer to some troubleshooting information in TABLE 9-3, if you want to use

a different location for your user directory.

The Settings Import wizard appears.

3. In the Settings Import wizard, specify whether you want to import your settings
from a previous version of the IDE.

■ If you do not want to import your previous user settings, select No and click

Finish to exit the wizard.

For supported Solaris or Red Hat Linux environments, the default user directory

is created and named $HOME/ffjuser40ee .

On a Microsoft Windows system, the user directory is created in the previous step

or set to the same user directory you specified in a previous installation of this

version of the IDE if you did not remove the previous UserDir value in the

registry.

C:\> cd ffj-install-dir\bin
C:\ ffj-install-dir\bin> runidew.exe
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■ If you want to import your previous user settings, select Yes and click Next.

You are prompted for the location of the user directory for the previously

installed IDE.

i. Specify the path or click Browse to locate the directory. Click Next.

The IDE imports the settings.

ii. Click Finish to exit the wizard.

The IDE continues with the startup and the Setup wizard appears.

4. If you are behind a firewall, specify the proxy server information.

5. Select the window mode, and click Next to continue with the setup.

6. Click Finish to continue with IDE startup, or click Next for additional setup
options.

If you clicked Finish, the IDE continues with the startup and several windows

appear. The registration wizard appears. Continue with Step 10 below.

(Solaris only) If you clicked Next and you installed the Solaris Developer Modules,

the Text Editor Preference pane appears. Continue with Step 7.

Otherwise, if you clicked Next, the Module Installation pane appears. Continue with

Step 8.

7. (Solaris only) In the Text Editor Preference pane, select the text editor you choose
to use with the IDE. Then, click Next to continue with the setup, or Finish to
continue with the IDE startup.

The installation of the Solaris Developer Modules includes the XEmacs and VIM text

editors. You can select from the IDE’s built-in editor, XEmacs, or VIM as the default

text editor to use with the IDE. If you decide to modify the default text editor at a

later time, choose Tools → Setup Wizard from the main menu of the IDE.

If you clicked Finish, the IDE continues with the startup and several windows

appear. The registration wizard appears. Continue with Step 10 below.

Otherwise, if you clicked Next, the Module Installation pane appears.
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8. In the Module Installation pane, specify which module you want enabled or
disabled. Then, click Next to continue with the setup, or Finish to continue with
the IDE startup.

By default, all the modules installed with the IDE are enabled. Disable a module by

doing the following:

a. Click on the Enabled property value for the module.

b. Click a second time and select False to disable the module.

If you clicked Finish, the IDE continues with the startup and several windows

appear. The registration wizard appears. Continue with Step 10 below.

If you clicked Next, the Update Center pane appears.

9. From the Update Center pane, Specify how often you want the IDE to
automatically check the Update Center and select the Forte for Java Update Center
as the update center from which you want to obtain the updates for modules of
your choice.

Click Finish to continue with the IDE startup. Several windows appear and the

registration wizard appears.

10. From the Registration wizard, select your preferred method of registration.

■ Choose “Register using the web” to register your Forte for Java 4 IDE software

using the web, or to edit your existing registration information if you have

changed Forte for Java 4 IDE editions.

The registration page appears on your web browser and you can proceed to

register the product, create a new Forte for Java Developer Resources account, or

update your account.

Registering your Forte for Java 4 IDE through the web enables you to:

■ Use the Update Center to download and install new modules and updates

specific to your environment

■ Subscribe to the Early Access Program (http://forte.sun.com/eap ) and

receive new, nonpublic builds of the IDE, as well as preview releases of Forte

for Java modules, patches, and bug fixes

■ Receive product announcements, if desired

■ Use the same user name and password to access the Update Center, the Early

Access Program, and the Sun Download Center (from which you might have

downloaded the Forte for Java 4 IDE)

If you are already registered with the Forte for Java Developer Resources, Sun

Download Center, or mysun.sun.com , you can use the same user name and

password, but you are prompted for additional information.
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Note – To maintain your Forte for Java Developer Resources account using the web,

choose Help → Registration Wizard from the main window of the IDE. Or, go to

http://forte.sun.com/services/registration/
accountmaintenance.html .

■ Register by FAX or mail.

This method of registration registers only your Forte for Java 4 IDE.

If you decide to register with Forte for Java Developer Resources at a later time,

choose Help → Registration Wizard from the main window of the IDE.

11. From the Automatic Update Check dialog box, specify whether you want to check
for new IDE updates.

■ If you reply Yes, the Update Center wizard appears. Follow the instructions on

the wizard to complete the setup for automatic update checking.

■ If you reply No, you can start the Update Center wizard at a later time by

choosing Tools → Update Center from the main window of the IDE.

12. Continue to Chapter 5 for instructions on validating your installation of the IDE.

Using the Startup Command-Line
Options
The IDE startup scripts for all supported platforms can be run with additional

options. These command-line options are specified with flags.

In a supported Linux or Solaris environments, for example, you might type:

On a supported Microsoft Windows system, for example, you might type:

Alternatively, you can put the options in the ffj-install-dir/bin/ide.cfg file. The

IDE reads this file before parsing any command-line options. You can break options

into multiple lines in ide.cfg .

TABLE 4-1 lists the startup command-line options for all supported platforms.

# runide.sh -help

C:\> runidew.exe -help
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TABLE 4-1 Command-Line Switch Options

Switch Options Description

-h
-help

Prints usage.

-jdkhome jdk-home-dir Selects an SDK other than the default SDK. On

Microsoft Windows, by default, the IDE checks

the registry and selects the latest SDK available.

-hotspot
-server
-client
-classic
-native
-green

Explicitly specifies the Java virtual machine

(JVM™) variant to be used.

The terms “Java virtual machine” and “JVM”

mean a virtual machine for the Java platform.

-cp:p additional-classpath Prepends the specified class path onto the IDE’s

class path.

-cp:a additional-classpath Appends the specified class path to the IDE’s

class path.

-ui UI_class-name Selects a given class as the IDE’s look and feel.

-fontsize size Sets the font size, expressed in points, in the

IDE’s user interface.

-single Launches the IDE from ffj-install-dir instead of

from your ffj-user-dir directory. Runs the Forte

for Java 4 IDE in single-user mode. The default

mode is multiuser.

-fortecc fcc-path (Solaris only) Specifies the path to the Forte

Compiler Collection to use for this session of

the IDE. Overrides any default settings created

in the IDE or user directory.

-userdir ffj-user-dir Explicitly specifies the ffj-user-dir directory (the

location where your user settings are stored). If

this option is not used in Solaris or Linux

operating environments, the location is

user-home-dir/ffjuser40ee . If this option is

not used on a Microsoft Windows system, the

user is prompted at the initial startup of the IDE

for the ffj-user-dir directory to use. On Microsoft

Windows systems, this value is stored in the

registry for later use.
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In the Solaris and Linux environments, users can modify startup scripts to suit their

needs.

-J jvm-flags Passes specified flags directly to the JVM.

-J-Xverify:none Tells the JVM not to verify the correctness of the

bytecode for faster startup. Bytecode

verification is a slow process. Whenever a class

is loaded, the JVM scans all bytecode and

detects an invalid byte sequence even if a

method is never called. Also, the JVM loads

certain classes referred to in method signatures

and in the method body, even though they are

not called during startup. However, setting this

flag removes some of the protection that the

Java language gives you. (Refer to the JVM

documentation for more information.)

-J-Xms24m Sets up the initial heap size of the JVM to 24

MB. This switch prevents the JVM from

extending the heap size during startup, which

enables faster startup time for the IDE.

TABLE 4-1 Command-Line Switch Options (Continued)

Switch Options Description
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CHAPTER 5

Validating Your Forte for Java 4
Installation

This chapter contains information on how to validate your installation of the Forte

for Java 4, Enterprise Edition. Instructions are provided to help you through the

creation of a simple HelloWorld web application using the J2EE Reference

Implementation 1.3.1.

Note – The following instructions assume you have already installed the J2EE

Reference Implementation 1.3.1 during the IDE installation.

Starting the Default J2EE Reference
Implementation Instance

The J2EE Reference Implementation server is configured automatically when you

installed the J2EE Reference Implementation 1.3.1 during the Forte for Java 4 IDE

installation. An instance of the J2EE Reference Implementation is added to the IDE’s

server registry. This instance is also set to be the default application server after the

IDE installation.

If the J2EE Reference Implementation 1.3.1 is not active when you deploy or execute

an application, it automatically starts.

The following instructions explain how to start and verify the default J2EE Reference

Implementation server instance:
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1. Start the Forte for Java IDE, if you have not already done so.

■ On Microsoft Windows systems, choose Forte for Java 4.0 EE → Forte for Java

from the Start menu, or start a command window and type the following:

■ In a supported Solaris operating environment, type the following command from

the command line:

2. Verify that the RI Home property is set correctly.

a. In the Explorer window of the IDE, click the Runtime tab and expand the
nodes for Server Registry and Installed Servers.

b. Right-click J2EE Reference Implementation 1.3.1 and choose Properties from
the contextual menu.

The property sheet for J2EE Reference Implementation appears.

c. Verify that the RI Home property already has a value of
ffj-install-dir/j2sdkee1.3.1.

If it does not, set the value by selecting the RI Home property and typing the

correct value.

3. Start the J2EE Reference Implementation 1.3.1 instance.

a. Expand the Server Registry and Installed Server nodes from the Runtime tab of
the Explorer window, if you have not already done so.

All the application servers that have already been installed are listed under the

Installed Servers node.

b. Expand the J2EE Reference Implementation 1.3.1 node.

You can see the RI instances that have already been added to the Server Registry.

C:\> cd ffj-install-dir\bin
C:\ ffj-install-dir\bin> runidew.exe

$ cd ffj-install-dir/bin
$ runide.sh [ ffj-ide-options]
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c. Right-click RI Instance 1 and choose Start Server from the contextual menu.

The corresponding messages appear in the Output window. For example, in a

Microsoft Windows system, you see the following:

4. Verify the server instance status in a web browser using
http://localhost:8000 for the URL.

If you have correctly integrated your server, you see the J2EE 1.3.1 Default Home

Page.

Note – If you receive an error message when verifying the server instance status,

refer to Chapter 9 for some troubleshooting hints. If you need to modify the default

port settings assigned to the J2EE Reference Implementation 1.3.1, refer to

Appendix B for information.

Creating a HelloWorld J2EE Application

The following steps guide you in creating a simple test application using the J2EE

Reference Implementation 1.3.1 that was installed with the IDE.

Note – The following instructions assume you have already started the default J2EE

Reference Implementation instance. See “Starting the Default J2EE Reference

Implementation Instance” on page 45 for more information.

1. Create a new directory called verificationApp .

2. Start the Forte for Java IDE, if you have not already done so.

■ On Microsoft Windows systems, choose Forte for Java 4.0 EE → Forte for Java

from the Start menu, or start a command window and type the following:

J2EE server listen Port: = 1050
Redirecting the output and error streams to the following files:
<ffj-install-dir>\j2sdkee1.3.1\logs\myhost\j2ee\j2ee\system.out
<ffj-install-dir>\j2sdkee1.3.1\logs\myhost\j2ee\j2ee\system.err
J2EE server startup complete.

C:\> cd ffj-install-dir\bin
C:\ ffj-install-dir\bin> runidew.exe
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■ In a supported Solaris operating environment, type the following command at the

command line:

3. Mount the new verificationApp directory in the IDE by choosing File →
Mount Filesystems from the main window of the IDE.

The New wizard appears.

a. Select Local Directory and click Next.

b. Select the newly created directory, verificationApp , and click Finish.

A new node for verificationApp appears on the Filesystems tabbed pane of

the Explorer window.

4. In the Filesystems tabbed pane of the Explorer window, create a new Java package
named hello by right-clicking the verificationApp node and choosing New →
Java package.

The New wizard for a Java package appears.

5. From the New wizard, type the name hello for the new Java package and click
Finish.

A new node for the hello package appears on the Filesystems tabbed pane of the

Explorer window.

6. In the Explorer window, right-click the hello node and choose
New → J2EE → Session EJB to create a new session bean named helloTest .

The New wizard for a session bean appears.

7. Specify the bean Name as helloTest , use all the default settings on the New
wizard, and click Finish.

The new helloTest(EJB) node appears on the Filesystems tabbed pane of the

Explorer window. Nodes for helloTest , helloTestBean , and helloTestHome
also appear.

8. Add a business method by right-clicking the helloTest(EJB) node and
choosing Add Business Method.

The Add New Business Method dialog box appears.

9. In the Add New Business Method dialog box, name the method sayHello .

a. Set the return type by selecting java.lang.String from the combo box.

b. Click OK.

$ cd ffj-install-dir/bin
$ runide.sh [ ffj-ide-options]
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10. Edit the sayHello method using the Source Editor.

a. In the Explorer window, expand the helloTest(EJB) node and expand the
Business Methods node.

b. Right-click sayHello() , and choose Open.

The Source Editor opens and displays the contents of the helloTestBean
method.

c. In the Source Editor, add one line, so the method looks like this:

11. Choose Build → Compile from the main window of the IDE or press F9 to compile
the sayHello method.

If no compilation errors were encountered, the Output window should display the

message Finished helloTestBean .

12. From the Filesystems tabbed pane of the Explorer window, create a new EJB Test
application by right-clicking the helloTest(EJB) node and choosing Create
New EJB Test Application.

The Create a New EJB Test Application dialog box appears.

13. Accept all the default values by clicking OK.

An EJB module called helloTest_EJBModule , a web module named

helloTest_WebModule , and an application named helloTest_TestApp are

created and automatically mounted in the IDE.

14. In the Filesystems tab of the Explorer window, right-click the
helloTest_TestApp node and choose Execute.

A progress monitor is displayed and the IDE switches to the Running tab. The

helloTest_TestApp is deployed and your web browser appears with the URL

displayed as http://localhost:8000/helloTest_TestApp/dispatch.jsp .

If the browser is not displayed automatically, open it manually and type

http://localhost:8000/helloTest_TestApp for the URL.

public java.lang.String sayHello() {
return “Hello there, world!”;

}
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Note – Make sure that your web browser is configured to not use proxy servers for

domains beginning with localhost.

If the http://localhost:8000/helloTest_TestApp/dispatch.jsp page is

displayed, the J2EE Reference Implementation server is working correctly.

You have now verified that your installation of the IDE and the J2EE Reference

Implementation is working properly. At this point, you can skip the steps remaining

in this chapter or continue to run the session bean’s method.

15. Run the session bean’s method by clicking the Invoke button next to
hello.helloTest create in the
http://localhost:8000/helloTest_TestApp/dispatch.jsp page on your
web browser.

The correct button is the first Invoke button on the page, under Invoke Methods in

the hello.helloTestHome section.

a. In the EJB Navigation section of the next page, click hello.helloTest[7] .

The number 7 might be some other number in your web browser.

b. Click Invoke next to java.lang.String sayHello .

The Results of the Last Method Invocation section displays the following:

You have completed running the session bean’s method.

Hello there, world!

Method Invoked: sayHello()
Parameters:
none
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CHAPTER 6

Customizing Your Installation

This chapter contains information to assist you in customizing your installation of

the Forte for Java 4, Enterprise Edition. It includes information about the PointBase

Server 4.2 Restricted Edition and the IDE’s internal UDDI Registry server.

Using Databases With the Forte for Java
IDE

The PointBase Server 4.2 Restricted Edition is available for installation with the Forte

for Java 4 IDE. You can use other databases with the IDE by configuring the JDBC™

enabled database drivers for those databases.

Note – The following instructions assume you have already installed the PointBase

Server 4.2 Restricted Edition during the IDE installation.

Using a PointBase Database

PointBase Server 4.2 Restricted Edition is the default database that is provided with

the Forte for Java 4 IDE installation. For information on using this database and

database tables, see the PointBase documentation at either

ffj-install-dir/pointbase/server/GettingStarted.html or

ffj-install-dir/pointbase/client/GettingStarted.html .
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Starting the PointBase Database Server

You have to start the PointBase database server before you can use it, whether you

want to access a PointBase database from an application you developed using the

IDE or you want to create your own tables or database with PointBase software.

To start the PointBase database server:

● Choose Tools → PointBase Network Server → Start Server from the main window
of the IDE.

Alternatively, on Microsoft Windows systems, start the PointBase server by choosing

Forte for Java 4.0 EE → PointBase → Network Server → Server from the Start menu.

The PointBase 4.2 window appears.

Stopping the PointBase Database Server

Note – The following action stops only the PointBase database server that was

started by choosing Tools → PointBase Network Server → Start Server.

To stop the PointBase database server:

● Choose Tools → PointBase Network Server → Stop Server from the main window
of the IDE or choose Server → Shutdown! from the PointBase 4.2 window.

Starting the PointBase Client Console

To start a PointBase console, do the following:

● In a supported Solaris or Red Hat Linux environment, type:

● On Microsoft Windows systems, start the PointBase client console by choosing
Forte for Java 4.0 EE → PointBase → Console from the Start menu.

A dialog named “Connect to Database” appears. Click OK to continue.

$ sh ffj-install-dir/pointbase/client/Console
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Stopping the PointBase Client Console

To stop the client console, terminate the window from which it is running.

Customizing Your PointBase Database

The J2EE Reference Implementation 1.3.1 is preconfigured to use the PointBase

Server 4.2 Restricted Edition server included with the IDE. Starting the J2EE

Reference Implementation 1.3.1 server does not start the PointBase server. You must

start the PointBase Server 4.2 Restricted Edition server separately, as previously

instructed in this chapter.

If, however, you want to create a different PointBase database for your tables, you

need to use the $J2EE_HOME/bin/j2eeadmin tool to update the

$J2EE_HOME/config/resource.properties file. The $J2EE_HOMEis set to the

ffj-install-dir/j2sdkee1.3.1 directory.

The j2eeadmin syntax to create a different PointBase database is as follows:

For example, in a Solaris environment, you might type the following at the

command line:

Alternatively, you can manually edit the

$J2EE_HOME/config/resource.properties file and modify the

jdbc.resources variable, as follows:

j2eeadmin -addJdbcDatasource jndi_name url

$ $J2EE_HOME/bin/j2eeadmin -addJdbcDatasource jdbc/DB1
jdbc:pointbase:server://localhost/ yourdatabase

jdbc.DataSource.0.url=jdbc:pointbase:server://localhost/ your-
database
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Using Other JDBC Enabled Databases

The following information applies to database drivers other than the driver for the

PointBase Server 4.2 Restricted Edition database.

You must place database driver files in the Forte for Java lib/ext directory before

you start the Forte for Java 4 IDE. If you do not do this, the dbschema wizard does

not enable you to select the proper database driver when you create a new schema.

You cannot mount the driver file in the IDE’s Explorer, nor can you simply place the

driver file in the CLASSPATHenvironment variable. You must copy the driver file

into the lib/ext folder.

The same database driver must also be added to the $J2EE_HOME/lib/system
directory so that the application server is aware of the new database driver. Read the

information contained in ffj-install-dir/j2sdkee1.3.1/doc/release/
ConfigGuide.html#12442 for more information on required steps for adding

more database drivers to the J2EE Reference Implementation 1.3.1 application server.

For more information on database configuration and adding new database drivers,

see http://www.sun.com/forte/ffj/resources/articles/configdb.html .

Using the IDE’s Internal UDDI Registry
Server

A single-user, internal UDDI registry is bundled with the IDE as a convenience for

end-to-end testing of your development process. This registry runs in a dedicated

Tomcat server, which the IDE starts and stops automatically when you start and stop

the registry server.

Note – The internal UDDI registry is configured with a single user. The name is

testuser and the password is testuser . Set this name and password as the

default for the internal registry.
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To start the internal UDDI registry server:

1. Expand the UDDI Server Registry node in the Explorer’s Runtime tabbed pane.

You should see the Internal UDDI Registry node.

2. Right-click the Internal UDDI Registry node and choose Start Server.

The IDE’s Output window displays server startup messages. You might also see

messages stating that the IDE is stopping a previous Tomcat server process.

Note – If the internal UDDI registry server is already running, the Start Server

menu item is inactive.

To stop the internal UDDI registry server:

1. Expand the UDDI Server Registry node in the Explorer Runtime tabbed pane.

You should see the Internal UDDI Registry node.

2. Right-click the Internal UDDI Registry node and choose Stop Server.

Server stop messages are displayed.

Note – If the internal UDDI registry server is not running, the Stop Server menu

item is inactive.
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CHAPTER 7

Using Other Application Servers
With the Forte for Java 4 IDE

Once you have successfully installed the IDE and validated the IDE installation by

creating a simple J2EE application (see Chapter 5 for more information), you can use

other application servers with the IDE.

This chapter contains information about using the BEA WebLogic Server 6.1 as the

default application server for applications you develop with the Forte for Java 4 IDE.

Note – You must first download the WebLogic Server Plug-in module from the

Update Center before you can proceed with the rest of this chapter. See “Updating

Modules With the Update Center” on page 61 for information on how to download

Forte for Java 4 modules. In the Update Center wizard, expand the Enterprise

Edition Modules node to locate the WebLogic Server Plug-in module.

Setting Up the WebLogic Environment

Note – WebLogic Server 6.1 requires version 1.3.1 of the Java runtime environment

(JRE). You must run the IDE with JRE 1.3.1 if you intend to deploy applications to

the WebLogic Server 6.1. Do not run the IDE and WebLogic Server 6.1 with the J2SE,

v. 1.4 platform or the JRE, v. 1.4.

The WebLogic Server 6.1 must be running before you can deploy an application to it.

However, before you start the application server, you must ensure that the WebLogic

environment is set up correctly.
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Note – If you deploy a J2EE application client to WebLogic Server 6.1, WebLogic

must be able to download its XML document definitions from the WebLogic web

site. If your connection to the web requires a proxy server, make sure that you

specify this setting in the IDE before deploying an application to the WebLogic

server. To set the proxy server, choose Tools → Setup Wizard and specify your proxy

and web browser settings in the General Forte for Java Settings pane of that wizard.

Setting Up the WebLogic Environment in a Solaris

Operating Environment

Follow these steps to set up the WebLogic environment in your Solaris operating

environment:

1. Shut down the IDE.

2. From a command window, ensure that you have a Bourne shell session.

If you do not yet have a Bourne shell session, type the following command:

3. Run the WebLogic environment setup script.

Type the following at the command prompt to run the setEnv.sh script:

For example, if your WebLogic home directory is /bea/wlserver6.1 and your

domain is mydomain , you would type the following command:

4. Start the Forte for Java 4 IDE.

In the same terminal window where the WebLogic environment was just set up, type

the following:

% sh
$

$ . WebLogicHomeDirectory/config/ Domain/setEnv.sh

$ . /bea/wlserver6.1/config/mydomain/setEnv.sh

$ ffj-install-dir/bin/runide.sh
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Setting Up the WebLogic Environment on a

Microsoft Windows System

If you installed WebLogic as a Microsoft Windows service, the server starts

whenever you restart Microsoft Windows. You do not need to start explicitly with

the script. If you did not install WebLogic as a Microsoft Windows service, follow

these instructions:

1. Shut down the IDE.

2. Run the WebLogic environment setup script.

At a command prompt, type the following:

For example, if your WebLogic home is c:\bea\wlserver6.1 and your domain is

mydomain , you would type the following command:

3. Start the Forte for Java 4 IDE.

In the same command window where the WebLogic environment was just set up,

type the following:

Configuring the BEA WebLogic Server
6.1 as the Default Application Server

You must install and start the BEA WebLogic Server 6.1 before you can use it with

the IDE.

Note – The BEA WebLogic Server 6.1 SP2 has been certified with this release of the

Forte for Java 4 IDE and is certified only to run with the Java 2 SDK, v. 1.3.1

software.

C:\> WebLogicHomePath\config\ Domain/setEnv.cmd

C:\> \bea\wlserver6.1\config\mydomain\setEnv.cmd

C:\> cd ffj-install-dir\bin
C: \ffj-install-dir\bin> runidew.exe
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Note – There is a known problem in deploying web services developed with the

Forte for Java 4 IDE to the BEA WebLogic 6.1 Server. The fix requires a patch to the

WebLogic server. You will not be able to deploy web services from the IDE to

WebLogic 6.1 without the patch. WebLogic customers with BEA support contracts

need to contact BEA Customer Support and request the patch for issue CR064391.

Follow these steps to make the BEA WebLogic 6.1 Server the default application

server for applications you create and deploy in the IDE.

1. If you have not already done so, start the IDE.

See Chapter 4 for instructions on how to start the IDE.

2. In the Explorer window, select the Runtime tab and expand the Server
Registry/Installed Servers node.

You should see the WebLogic Server 6.1 node.

3. Right-click the WebLogic Server 6.1 node and choose Properties.

The property sheet for the WebLogic server appears.

4. Set the value for the WebLogic Home property.

a. Select the WebLogic Home property.

b. Type weblogic-install-dir/wlserver6.1 . and close the property sheet.

5. Add a WebLogic server instance by right-clicking the WebLogic Server 6.1 node
and choosing Add Server Instance.

6. Set the password value in the property sheet.

a. Right-click the WebLogic server instance you just created and choose
Properties.

The property sheet for the instance appears.

b. Select the Password property and type the password you specified during the
WebLogic server installation as the property’s value.

c. Close the property sheet.

7. Right-click the WebLogic Server Instance 1 and choose Set As Default Application
Server.

The WebLogic server is now the default application server used by the IDE.
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CHAPTER 8

Where to Go From Here

This chapter contains information about available documentation resources and how

to obtain IDE updates from the Forte for Java Update Center.

Updating Modules With the Update
Center

Once you have Forte for Java 4, Enterprise Edition installed in your system, use the

Update Center to add new IDE modules or update the existing IDE modules already

installed in your system. Use the following steps to update your IDE:

1. Start the IDE.

See Chapter 4 for instructions on how to start the IDE.

2. Select the Update Center from the IDE’s Welcome screen or choose
Tools → Update Center from the main window of the IDE.

The Update Center wizard appears.

3. Select Forte for Java Update Center as the Update Center and deselect NetBeans
Update Center.

4. Click the Proxy Configuration to set your proxy configuration, if needed.

The Proxy Configuration dialog box appears. Modify the values as needed and click

OK to return to the Update Center wizard.

5. Click Next and type your Forte for Java Update Center login name and password.

See Step 10 in “Setting Up Your Forte for Java 4 IDE” on page 37 for information on

registering and creating a login name and password.

The Update Center displays the modules that are available to you.
61



6. Select individual modules or select all by clicking the >> button. Use the < button
to remove those versions that are not appropriate to your platform.

7. Click Next and follow the Update Center installation procedure.

The IDE installs the selected modules and then restarts itself.

For more information about how the Update Center works and Sun’s privacy policy

regarding your personal information, see the Developer Resources Site FAQs at

http://forte.sun.com/ffj/resources/sitefaq.html .

Other Documentation Resources

You can access the following resources to learn more about the different features of

the IDE and how to use them:

■ The online help is available by accessing the Help menu from the main window

of the IDE. You can view the available help sets by choosing Help Sets from the

Help menu.

■ A set of programming books, tutorials, and code examples are available at

http://forte.sun.com/ffj/documentation/index.html .

■ The Forte for Java Developer Resources site at

http://forte.sun.com/ffj/index.html also contains a wealth of

information and support resources, including Forte for Java news, technical

articles, a support knowledge base, forums, and more.

You can also access this site from the IDE by choosing Help → Web Resources

from the main window of the IDE.
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CHAPTER 9

Troubleshooting

This chapter provides some troubleshooting hints to help you during the

installation, startup, configuration, and use of the Forte for Java 4 IDE.

Using the solaris_patch_installer
TABLE 9-1 describes some errors you might encounter during installation of Solaris

patches using the solaris_patch_installer script.

TABLE 9-1 solaris_patch_installer Errors

Problem Solution

The solaris_patch_installer aborted while

attempting to apply one of the required Solaris patches

on your system.

1. Write down the patchID of the last patch that the

solaris_patch_installer tried to install.

2. Obtain a newer revision of that patch from

http://sunsolve.sun.com , if one is available.

3. Install the new revision on your system using the

patchadd utility. (If you are unfamiliar with or

unsure about installing Solaris packages or the

J2SE, v. 1.4.0 platform on your Solaris

environment, contact your Solaris system

administrator for assistance.)

4. Run the solaris_patch_installer again to

ensure you have all the required Solaris 8 patches

on your system.
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Installing the Forte for Java 4 IDE

TABLE 9-2 describes some errors you might encounter during the Forte for Java 4 IDE

installation.

Receipt of an error message similar to the following,

after running the solaris_patch_installer on a

newly installed Solaris 8 (update 7) environment:

# ./solaris_patch_installer

Solaris Patch Installer for J2SE, v.1.4.0
Installing 109147-14... successfully
installed
Installing 108434-06...

...

Installing 108528-13... attempting to
patch a package that is not installed
Installing 108652-51... successfully
installed
Installing 108921-13... already applied
Installing 108940-40... successfully
installed
Installing 108773-12... pkgadd failed
Cannot continue patch installation.
For more details, please look at
/var/tmp/solaris_patch_installer.log

Run the solaris_patch_installer script a

second time. If you continue to have problems,

contact your Solaris system administrator.

TABLE 9-2 Forte for Java 4 IDE Installation Errors

Problem Solution

Receipt of the following error message while

installing the Forte for Java 4 IDE:

Error writing file = There may not
be enough temporary disk space.
Try using -is:tempdir to use a
temporary directory on a partition
with more disk space

Start the installer with the -is:tempdir command-line option,

in order to specify a directory on a disk with more free space.

For example, in a Solaris operating environment, you might type

the following at the command prompt:

$ ffj_ee_solsparc_en.bin -is:tempdir temporary-
directory

TABLE 9-1 solaris_patch_installer Errors (Continued)

Problem Solution
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The Forte for Java 4 installer fails and

displays a message that there is not enough

available disk space to use for installation.

But, the filesystem you specified to use for

installing the IDE has plenty of available disk

space.

The filesystem you have specified may be symbolically linked to

another filesystem whose large amount of disk space is not

recognized. For example, in a Solaris environment,

/export/home has 2 GB of space and / has 100 MB. The /opt
directory is symbolically linked to /export/home . If you

specified /opt/forte4j as the IDE installation directory, the

Forte for Java 4 installer does not recognize the symbolic link to

/export/home , which has 2 GB of available disk space. The

installer only recognizes the / directory, which is the target

directory for /opt and only has 100 MB.

To correct the problem, specify the IDE’s installer to directly use

the filesystem with the larger available disk space. For the above

example, specify the /export/home as the installation directory.

Receipt of the following error message while

installing the Forte for Java 4 IDE:

Error: Could not find JVM

Start the installer with the -is:javahome command-line option,

in order to specify a directory on a disk with more free space.

For example, in a Solaris operating environment, type the

following at the command prompt:

$ ffj_ee_solsparc_en.bin -is:javahome javahome

(Solaris or Linux environments only) The

Forte for Java 4 installer looks like it is hung,

after it was started. No messages are

displayed.

You may not have set the DISPLAY environment variable

correctly. If you are installing on your local system, the DISPLAY
environment variable should be set to :0 .0. If you are using a

superuser (root) account or doing a remote installation, set your

DISPLAY environment variable to your local system.

For example, to set the DISPLAY variable from a root account

that is using a C-shell, type the following in the command

window you used to log into the root account:

setenv DISPLAY your-local-host:0 .0.

Run the installer again from the same command window.

The Forte for Java 4 IDE installer exits

without installing the product. No messages

are displayed.

These are the possible causes and solutions:

• The file you have downloaded from the Forte for Java 4

product download page is not complete. Download the file

again and check that the size of the downloaded file is the

same as the file size specified on the product download page.

Run the IDE installer again.

• You have specified an invalid command-line parameter in the

installer.sp file. Check the file and correct any incorrect

command-line parameter setting. Run the IDE installer again.

The -is:tempdir command-line parameter

is not working.

Make sure that you are using the correct syntax for the

command-line parameter for the installer. For example, on a

Solaris environment, the syntax is as follows:

ffj_ee_solsparc_en.bin -is:tempdir temporary-directory

TABLE 9-2 Forte for Java 4 IDE Installation Errors (Continued)

Problem Solution
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Starting Up the Forte for Java 4 IDE

TABLE 9-3 describes some errors you might receive during startup and configuration

of the newly installed Forte for Java 4 IDE software.

TABLE 9-3 Forte for Java 4 IDE Startup and Configuration Errors

Problem Solution

Receipt of an error message similar to the

following during the IDE startup in a

supported Solaris environment:

Error: No J2SE was found at
/usr/j2se/bin/java
ERROR: The following required 5.8
patches have not been installed
on system “myserver”: 106950-16
106327-11 106541-17

NOTE: You can download and
install the J2SE[tm] and related
Solaris[tm] patches from
http://access1.sun.com/forte/.

Warning:Current runtime
environment does not satisfy
minimum requirements.

Install the J2SE, v. 1.4.0 platform on your system. For a Solaris 8

operating environment, include any necessary patches. Refer to

Chapter 2 for more information on installing this software on

your system.

Receipt of the following error message after

starting the IDE:

Error: Unable to load java.dll

Make sure there is no space in the name of the directory in

which you have installed the J2SE, v. 1.3.1 or v. 1.4.0 platform.

Forte for Java 4 IDE is not pointing to the

J2SE, v. 1.4.0 platform you had specified

during the IDE installation and you receive

an error message similar to the following:

ERROR: The J2SE[tm] 1.2.1 found
at /usr/java1.2/bin/java cannot
be used by the IDE. J2SE[tm] 1.4
is recommended.
NOTE: You can download and
install the J2SE[tm] and related
Solaris[tm] patches from
http://access1.sun.com/forte/.

Warning:Current runtime
environment does not satisfy
minimum requirements.

Check the Java environment variables already set prior to

starting the IDE and unset them.

The values of the $JAVA_PATHand $JDK_HOMEenvironment

variables override the value of the J2SE SDK path you specified

during the IDE installation. You need to unset these

environment variables or use the -jdkhome command-line

option when starting the IDE.
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The user directory is created in the wrong

location in a Microsoft Windows system.

If you have previously installed any edition of the Forte for

Java 4 IDE in a Windows environment, the location of the user

directory is recorded in the Microsoft Windows Registry under

HKEY_CURRENT_USER/Software/Sun Microsystems,
Inc./Forte for Java/EE/4.0 . This value is not deleted

when you uninstall the Forte for Java 4 IDE. Therefore, when

you install another version of the Forte for Java 4 IDE, the user

directory specified in a previous Forte for Java 4 IDE

installation is reused.

If you want to use a different location for the user directory, do

the following:

1. Uninstall the Forte for Java 4 IDE.

2. In a command window, type regedit to start the Microsoft

Windows Registry editor.

3. From the Registry editor, expand the HKEY_CURRENT_USER
registry and the keys for Software/Sun
Microsystems, Inc./Forte for Java/EE/4.0

4. Right-click the UserDir value and choose Delete from the

contextual menu.

5. Install the Forte for Java 4 IDE again.

6. After installation, start the Forte for Java 4 IDE and when

you are prompted, specify a new location for the user

directory.

TABLE 9-3 Forte for Java 4 IDE Startup and Configuration Errors (Continued)

Problem Solution
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Running Web Services

TABLE 9-4 describes some error messages you might get when running a web service

using any of the application servers supported by the IDE.

TABLE 9-4 Errors When Running a Web Service With Any Application Server

Problem Solution

Receipt of the following exception:

[SOAPException : faultCode=SOAP-ENV :

Client; msg=Connection shutdown:
JVM_recv in socket input stream
read; targetException:

java.net.SocketException:
Connection shutdown: JVM_recv in

socket input stream read]

The Web Context property of the web module in the J2EE

application does not match the context root specified in the

SOAP RPC URL property of the web service. To obtain the

Web Context property of the web module:

1. Expand the J2EE application to which the web service was

added.

2. Right-click the web module of the web service (this is the

file whose name ends in _War) and choose Properties.

3. The Web Context property is the last property displayed

in the Properties window.

To obtain the context of the SOAP RPC URL property of the

web service:

1. Right-click the web service node and choose Properties.

2. The SOAP RPC URL property displays a value that is

similar to the following:

http://localhost:8000/MyService/
servlet/rpcrouter

In this case, the context root is MyService and this should

also be the value of the Web Context property of the web

module in the J2EE application.

Receipt of the following exception:

[SOAPException: faultCode=SOAP-
ENV:Client; msg=Error opening
socket: Connection refused:
connect; targetException=
java.lang.IllegalArgumentException:
Error opening socket: Connection
refused: connect]

Changes were made to the web service and you did not

refresh the web service client that was making the call to the

web service. To refresh the web service client when a change

has been made to the web service that it is calling:

1. Right-click the web service client node to display its

contextual menu.

2. Choose Refetch WSDL. This regenerates the client proxy

to reflect the changes made to the web service.
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Web Services Using UDDI

TABLE 9-5 describes some error messages you might get when running a web service

using UDDI.

TABLE 9-5 Errors When Running a Web Service Using UDDI

Problem Solution

Receipt of an empty web page when viewing

.wsdl files.

Versions of the Netscape web browser prior to 6.0 do not

display the .wsdl file. Use a later version of the Netscape web

browser.

Receipt of the following exception when

searching for anything in a UDDI registry

using the New Client wizard:

IllegalArgumentException

If you intend to use UDDI, you need to set the User Proxy

Server name and port information when you first run the Forte

for Java 4 IDE. You can use either of the following to set the

User Proxy Server information:

• When you start the IDE after installation, specify the User

Proxy Server name and port from the second dialog box.

• Choose Tools → Setup Wizard from the main window of the

IDE and provide the User Proxy Server name and port.

You must restart the IDE for the values to take effect.

Receipt of the following exception in the

registry server Tomcat output window when

inquiring or publishing to the internal UDDI

server:

[WARN] registry_server - -
org.xmldb.api.base.XMLDBException
while connecting:
org.apache.xnode.XNodeException:
aborting connection attempt.

A possible cause is that a previous Xindice server instance was

not gracefully terminated:

1. Terminate the corresponding Java processes associated with

that Xindice server instance.

2. Restart the IDE.

Always terminate the internal UDDI registry server using the

following steps:

1. Select the Runtime tab of the Explorer.

2. Expand the UDDI Server Registry node.

3. Right-click the Internal UDDI Registry and choose Stop

Server from the contextual menu.
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Using WebLogic 6.1

TABLE 9-6 describes some error messages you might get when using WebLogic Server

6.1.

TABLE 9-6 Errors When Using WebLogic Server 6.1

Problem Solution

Inability to deploy web services from the

Forte for Java 4 IDE to the BEA WebLogic

Server 6.1.

There is a known problem in deploying web services

developed with the Forte for Java 4 IDE to the BEA WebLogic

Server 6.1. The fix requires a patch to the server. WebLogic

customers with BEA support contracts need to contact BEA

Customer Support and request the patch for issue CR06439.

WebLogic Server 6.1 is unable to download

its XML document definitions from the BEA

web site.

If you deploy a J2EE application client to WebLogic Server 6.1,

WebLogic must be able to download its XML document

definitions from the WebLogic web site. If your connection to

the web requires a proxy server, make sure that you specify

this setting in the IDE before deploying an application to the

WebLogic server. To set the proxy server, choose

Tools → Setup Wizard and specify your proxy and web

browser settings in the General Forte for Java Settings pane of

that wizard.
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Using J2EE Reference Implementation
1.3.1

TABLE 9-7 describes some error messages you might get when using J2EE Reference

Implementation 1.3.1.

TABLE 9-7 Errors When Using J2EE Reference Implementation 1.3.1

Problem Solution

Receipt of the following error on your browser after

deploying the HelloWorld J2EE application you

created in “Creating a HelloWorld J2EE Application”

on page 47:

ERROR: The requested URL could not be
retrieved. While trying to retrieve the
URL:
http://localhost:8000/helloTest_TestApp/
dispatch.jsp the following error was
encountered: Connection Failed .

If your system is behind a firewall, make sure that

your browser is configured to not use proxy servers

for domains beginning with localhost .

Receipt of the following error message:

org.omg.CORBA.INTERNAL: minor code:
1398079697 completed: No
...
java.lang.RuntimeException: Unable to
create ORB. Possible causes include
TCP/IP ports in use by another process
...
Error executing J2EE server...

This error occurs when another process is already

using the 1050 listen port. You can either shut down

the other process or change the port number assigned

to J2EE Reference Implementation 1.3.1 to something

other than 1050, for example, 11050. This error can also

occur if the 1060 listen port is in use, even if the 1050

port is not in use. Do the following to correct the

problem:

1. Determine whether the 1050 port is in use, the 1060

port is in use, or both are in use.

2. Change whichever is in use. To change the 1050

port assignment, you must modify the

$J2EE_HOME\config\orb.properties file.To

change the 1060 port assignment, use a text editor

to modify the $J2EE_HOME\setenv.bat (for

Microsoft Windows systems), or

$J2EE_HOME/setenv.sh file (for Solaris or Red

Hat Linux environments).
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Receipt of an error message similar to the following:

Starting web service at port:8000
Starting secure web service at
port: 7000
J2EE SDK/1.3.1
LifecycleException: null.open:
java.net.BindException: Address in use:
JVM_Bind
...
Error executing J2EE server...

This error occurs if either the 7000 or 8000 web server

port is in use. Set the http.port or https.port
properties in the

$J2EE_HOME/config/web.properties file to a

different web server port.

Receipt of an error message similar to the following:

Starting web service at port:8000
Starting secure web service at port:7000
J2EE SDK/1.3.1
Starting web service at port:9191
J2EE SDK/1.3.1 LifecycleException:
null.open: java.net.BindException:
Address in use: JVM_Bind
...
Error executing J2EE server...

This error occurs if the 9191 EJB server port is in use.

Modify the $J2EE_HOME/config/ejb.properties
file to use a different EJB server port.

Receipt of ClassNotFoundException when

deploying an application using J2EE Reference

Implementation 1.3.1.

This problem might occur if you installed the IDE to

run with the Java 2 SDK, v. 1.3.1, and you started the

IDE with the -jdkhome switch option set to a Java 2

SDK, v. 1.4.0 installation. Your application might

compile, but you could receive the

ClassNotFoundException at deployment time if

you used a Java API that is specific only to Java 2 SDK,

v. 1.4.0.

Note that the J2EE Reference Implementation 1.3.1

server is set to use the Java 2 SDK specified during the

IDE installation and not the Java 2 SDK specified via

the -jdkhome switch option.

Do one of the following to correct the problem:

• Edit the JAVA_HOMEsetting in the J2EE Reference

Implementation startup file to use the desired

version of the Java 2 SDK. The setting is found in

$J2EE_HOME/bin/userconfig.sh in Solaris and

Linux environments or in the

$J2EE_HOME/bin/userconfig.bat file on

Microsoft Windows systems.

• Use a comparable Java API from the Java 2 SDK,

v. 1.3.1 platform.

TABLE 9-7 Errors When Using J2EE Reference Implementation 1.3.1 (Continued)

Problem Solution
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Receipt of the following exception:

java.lang.RuntimeException: Could not
initialize j2ee server

This error occurs if another application has already

taken the port number that the J2EE Reference

Implementation server is trying to use. You can reboot

the J2EE Reference Implementation server to get the

port number before the other application does, or

troubleshoot the error by following these steps:

1. Open your

$J2EE_HOME\config\orb.properties file and

make a note of the port number.

2. Use the netstat command to see if the number is

in use. For example, in a Solaris operating

environment, type something similar to the

following in a command window:

netstat -a | grep port-number
3. If the number is in use by another process, you

need to change the port being used by the J2EE

Reference Implementation server or by the other

process. To find a free port, try running the

netstat command again and remove the last

couple of digits of the port-number. For example, in

a Solaris environment, you might type:

netstat -a | grep 104
This command lists all of the 104 ports in use. If

there is a number missing, change the

$J2EE_HOME\config\orb.properties file to

the number missing from the list.

TABLE 9-7 Errors When Using J2EE Reference Implementation 1.3.1 (Continued)

Problem Solution
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APPENDIX A

Solaris Patch Identifications and
Descriptions

TABLE A-1 provides the patch identification numbers and patch descriptions included

with the solaris_patch_installer for the Solaris 8 SPARC Platform Edition.

TABLE A-1 Patch Identifications and Descriptions for Solaris 8 SPARC Platform Edition

Patch Identification Number Patch Description

109147-14 Solaris 8 interprocedural optimizer

108434-06 Solaris 8 libC sparc

108435-06 V9 libC

111293-04 /usr/lib/libdevinfo.so.1

112334-01 /usr/include/sys/archsystem.h

111310-01 /usr/lib/libdhcpagent.so.1

108528-13 SIGEMT

108652-51 Xserver

108921-13 CDE 1.4 dtwm

108940-40 Motif 2.1

108773-12 X input methods

109607-01 /usr/include/iso/stdlib_iso.h

112003-03 Fontset

108989-02 Accounting

108827-17 Threads
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APPENDIX B

Port Usage in the Forte for Java 4
IDE

TABLE B-1 provides a listing of the ports used in the Forte for Java 4, Enterprise

Edition IDE. It includes ports used by Forte for Java modules, third-party

components, and application servers available for use with the IDE. Also included is

information on whether the default port assignment can be modified and how to

make the modification.

TABLE B-1 Port Usage in Forte for Java 4, Enterprise Edition IDE

Names of Module,
Application Server, or
Third-Party
Components

Default
Port
Number
Assigned Description Information on Modifying Default Port Assignment

NetBeans Open File

Module

7318 Open file

server

The default port assignment can be modified using the

properties editor for the Open File Server:

1. Choose Tools → Options menu from the main window of the

IDE.

2. From the Options window, expand the IDE Configuration

node.

3. Expand the Server and External Tool Settings node, right-

click Open File Server, and choose Properties from the

contextual menu.

4. Click the current value for Port property and type a different

port number.

NetBeans Internal

HTTP Server

Module

8082 Embedded

server

HTTP

The default port assignment is automatically changed if a

conflict is detected.

External Editor 3219 The default port assignment can be modified through the

external editor’s options pane.
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PointBase Restricted

Edition

9092 On Microsoft Windows systems, the default port assignment

can be modified in the PointBase startup script, server.bat ,

under the $FORTE4J_HOME/pointbase/server directory.

Use the following steps to modify the script:

1. Go to the $FORTE4J_HOME/pointbase/server directory

and create a copy of the server.bat file.

2. Name the new file server _newportnum.bat.
3. Change the port number information in the new file to

newportnum.

4. Run the server _newportnum.bat script in a command

window.

In Solaris and Red Hat Linux environments, start the PointBase

server from the $FORTE4J_HOME/pointbase/server
directory by typing the following at the command line:

Server /port: newportnum /win &

TABLE B-1 Port Usage in Forte for Java 4, Enterprise Edition IDE (Continued)

Names of Module,
Application Server, or
Third-Party
Components

Default
Port
Number
Assigned Description Information on Modifying Default Port Assignment
78  Forte for Java 4, Enterprise Edition Getting Started Guide • June 2002



Tomcat 4.0.1 8015 Server

adminis-

tration

The default port number can be modified using the properties

editor for the internal Tomcat 4.0.1 server:

1. On the Runtime tab of the Explorer, expand the Server

Registry node and the Installed Servers node.

2. Expand the Tomcat 4.0 node, right-click the Internal node,

and choose Properties from the contextual menu.

3. Click the current value for the Server Port property and type

the desired port number.

8081 Server

HTTP

The default port number can be modified using the properties

editor for the Host to be edited:

1. On the Runtime tab of the Explorer, expand the Server

Registry node and the Installed Servers node.

2. Expand the Tomcat 4.0 node and expand the relevant

installation node.

3. Right-click the node representing the Host to be edited, and

choose Properties from the contextual menu.

4. Click the value for the HTTP Connector property field and

type the desired port number.

8443 Redirec-

ting

You can modify the Tomcat configuration file,

ffj-install-dir/tomcat401/conf/server.xml .

Be aware that you edit the server.xml file at your own risk.

Be sure to create a backup version of your working

server.html file before beginning to edit by hand.

1. On the Runtime tab of the Explorer, expand the Tomcat 4.0

node under the Installed Servers node.

2. Right-click the node for the installation of Tomcat that you

want to edit. From the contextual menu, choose Configure

(server.xml ).

The server.xml file appears in the Source Editor. You can now

edit server.xml to modify the default port number.

11555 IDE

debugger

connection

The default port number can be modified using the properties

editor for the internal Tomcat 4.0.1 server:

1. On the Runtime tab of the Explorer, expand the Server

Registry node, and then expand the Installed Servers node.

2. Expand the Tomcat 4.0 node, right-click the Internal node

and choose Properties from the contextual menu.

3. Select the Debugger tab.

4. Click the current value for the Debugger Port property and

type the desired port number.

TABLE B-1 Port Usage in Forte for Java 4, Enterprise Edition IDE (Continued)

Names of Module,
Application Server, or
Third-Party
Components

Default
Port
Number
Assigned Description Information on Modifying Default Port Assignment
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J2EE Reference

Implementation

1.3.1 (bundled with

Forte for Java 4,

Enterprise Edition)

1050 ORB/IIOP Use a source editor of your choice to modify the

orb.properties file found in the $J2EE_HOME/config
directory. Modify the default port number with another port

number that is unused. The property is listed in the file as

orb.properties:port=1050 .

1060 ORB

Listen-

Socket

Use a source editor of your choice to modify either the

setenv.bat file (for Microsoft Windows systems) found in the

$J2EE_HOME\bin directory or the setenv.sh file (for Solaris

and Red Hat Linux environments) found in the

$J2EE_HOME/bin directory. Modify the last four digits on the

line that defines the LISTEN_OPTIONS environment variable.

8000 Web server

(HTTP)

Use a source editor of your choice to modify the

web.properties file found in the $J2EE_HOME/config
directory. The property is listed as in the file as

web.properties:http.port=8000 .

7000 Secure web

server

(HTTPS)

Use a source editor of your choice to modify the

web.properties file found in the $J2EE_HOME/config
directory. The property is listed in the file as

web.properties:https.port=7000 .

9191 EJB service Use a source editor of your choice to modify the

ejb.properties file found in the $J2EE_HOME/config
directory. The property is listed as

ejb.properties:http.port=9191 .

TABLE B-1 Port Usage in Forte for Java 4, Enterprise Edition IDE (Continued)

Names of Module,
Application Server, or
Third-Party
Components

Default
Port
Number
Assigned Description Information on Modifying Default Port Assignment
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Java Web Services

Developer Pack

UDDI Server

(bundled with Forte

for Java 4,

Enterprise Edition)

8095 Tomcat

server port

for registry

server

The default port assignment can be modified in the

ffj-install-dir/jwsdp /conf /server.xml :

1. Open the server.xml file in a text editor.

2. Replace the port number.

3. Restart the IDE.

8089 Tomcat

HTTP port

for registry

server

The default port assignment can be modified in the

ffj-install-dir/jwsdp /conf /server.xml :

1. Open the server.xml file in a text editor.

2. Replace the port number.

3. Restart the IDE.

4080 Xinidce

HTTP

The default port assignment can be modified in the

ffj-install-dir/jwsdp /tools /xindice /config /system.xml :

1. Open the system.xml file in a text editor.

2. Replace the port number.

3. Restart the IDE.

WebLogic 6.1 7001 Server

HTTP

The default port assignment can be modified during the

installation of the WebLogic 6.1 server.

7002 Server

HTTPS

The default port assignment can be modified during the

installation of the WebLogic 6.1 server.

TABLE B-1 Port Usage in Forte for Java 4, Enterprise Edition IDE (Continued)

Names of Module,
Application Server, or
Third-Party
Components

Default
Port
Number
Assigned Description Information on Modifying Default Port Assignment
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